# Table of Contents

- Finding Information — What and How ............................................. 3
  - For Windows 95, 98, 2000, and NT 4.0 Users .................................. 3
  - For Windows 3.1x Users ................................................................. 3
  - For DOS Users ............................................................................. 3

**Printing Basics** .............................................................................. 4
- Buttons and Lights ........................................................................ 4
- Paper Trays .................................................................................... 5
  - IN Tray ....................................................................................... 5
  - OUT Tray .................................................................................... 5
- How to Print .................................................................................. 6
  - How to Print in Windows 95, 98, 2000 and NT 4.0 ...................... 7
  - How to Print in Windows 3.1x .................................................... 9
- HP DeskJet Toolbox ........................................................................ 13
  - Windows 95, 98, 2000, and NT 4.0 .......................................... 13
  - Windows 3.1x ........................................................................... 15
- Printer Settings Taskbar Icon ....................................................... 16
  - Warning Message Indicator ...................................................... 16
  - Determining the Number of Pending Warning Messages ........... 18
  - Opening the Default Print Settings Dialog Box ....................... 18
  - Displaying Print Cartridge Warning Messages ....................... 18
  - Opening the Printer Properties Dialog Box ......................... 18
  - Printer Settings Taskbar Icon Shortcuts .................................. 18

**Beyond the Basics** ...................................................................... 30
- Automatic Paper-Type Sensor ......................................................... 19
  - How to Use the Automatic Paper-Type Sensor ....................... 19
- Automatic Two-Sided Printing ...................................................... 20
  - Printing with the Automatic Two-Sided Printing Module ......... 21
- Infrared (Ir) Printing ...................................................................... 22
  - Using Infrared with a Laptop or Notebook running Windows 98 ... 23
  - Printing using a Palm Pilot ......................................................... 26
  - Printing using an HP PhotoSmart Digital Camera ................... 27
  - Printing using a Windows CE Device ....................................... 28
- Printer Maintenance Tips ............................................................... 29

- Getting the Right Paper ............................................................... 30
  - Printing on Different Types of Paper and Media .................... 30
  - Manual Two-Sided Printing ..................................................... 31
  - Printing Transparencies ............................................................. 32
  - Printing Single Envelopes ......................................................... 33
  - Printing a Stack of Envelopes .................................................. 34
  - Printing Business Cards, Index Cards, and Other Small Media .. 35
  - Printing Labels ......................................................................... 36
  - Printing Photographs ................................................................. 37
  - Printing Greeting Cards ............................................................. 38
  - Printing Iron-On Transfers ....................................................... 39
  - Printing Posters ........................................................................ 40
  - Printing Banners .................................................................... 41
Print Cartridges ................................................. 42
  Print Cartridge Status ........................................ 42
  Replacing Print Cartridges .................................... 44
  To Replace a Print Cartridge ................................ 44
  Storing Print Cartridges ...................................... 46
  Cleaning Print Cartridges .................................... 46
  When Do You Need to Clean? ................................ 46
  If You See Missing Lines or Dots .............................. 46
  If You See Ink Streaks ....................................... 47
  Manually Cleaning the Print Cartridges and Print Cartridge Cradle .......................... 47
  Damage Resulting from Refilling the Print Cartridges ........................................ 49

Problems? .................................................... 50
  Troubleshooting Tips ........................................ 50
  HP Customer Care ............................................ 75
    HP Customer Care Online .................................. 75
  Printer Software Updates .................................... 76
  HP Customer Care Repair .................................... 77
  HP Customer Care by Phone ................................ 77
  Extended Warranty Options ................................ 80

More About Your Printer ................................. 81
  Specifications ................................................ 81
  System Requirements ....................................... 85
  Language Codes .............................................. 86
  Supplies and Accessories ................................... 87
  Ordering Information ......................................... 91
  Legal Information ........................................... 93
  Environmental Statement ................................... 95

Index ....................................................... 96

Acknowledgments
Microsoft, MS, MS-DOS, and Windows are registered trademarks of Microsoft Corporation.
Pentium is a U.S. registered trademark of Intel Corporation.
TrueType is a U.S. trademark of Apple Computer, Inc.
Adobe and Acrobat are trademarks of Adobe Systems Incorporated.
Palm, Palm III, Palm V, and Palm VII are registered trademarks of 3Com Corporation or its subsidiaries.

Notice
The information contained in this document is subject to change without notice.
Hewlett-Packard Company makes no warranty of any kind with regard to this material, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose.
Hewlett-Packard shall not be liable for any errors or for incidental or consequential damages in connection with the furnishing, performance, or use of this material.
All rights reserved. Reproduction, adaptation, or translation of this manual is prohibited without prior written permission of Hewlett-Packard Company, except as allowed under the copyright laws.
Edition 1, July 2000
© Copyright Hewlett-Packard Company 2000
Finding Information — What and How

For Windows 95, 98, 2000, and NT 4.0 Users


  - If you do not have Adobe Acrobat Reader installed, begin printer software installation process, select View User's Guide, and follow on-screen instructions to install Adobe Acrobat Reader.

  - If you have Adobe Acrobat Reader installed, go to Start ➔ Programs ➔ HP DeskJet 990C Series ➔ View User's Guide.

- Consult the Release Notes file in the HP DeskJet 990C Series program group for information about hardware and software compatibility. To access the Release Notes, click on Start ➔ Programs ➔ HP DeskJet 990C Series.

For Windows 3.1x Users

- Windows 3.1x specific information is only found in the electronic User's Guide.

  - If you have Adobe Acrobat Reader on your computer, begin the printer software installation process and select View User's Guide.

  - If you do not have Adobe Acrobat Reader on your computer, begin the printer software installation process, select View User's Guide, then follow on-screen instructions to install Adobe Acrobat Reader. Begin the printer software installation process again, and select View User's Guide.


  - Consult the Release Notes for information about hardware and software compatibility. Open this file by double-clicking the HP DeskJet 990C Series Release Notes icon in the HP DeskJet Utilities program group.

For DOS Users

If you are using DOS, information can be found in a text document (dosread.txt). This document is on the printer software CD in the \language code\djcp directory. For example, “enu” is the language code for English, so dosread.txt is located in the \enu\djcp directory. For a list of language codes, see page 86.

If you have diskettes, the file is located on the HP DeskJet Control Panel for DOS diskette.
Buttons and Lights

The HP DeskJet 990C Series printer buttons (shown below) let you turn the printer on and off, cancel a print job, or resume printing. The lights give you visual cues about the state of your printer. The buttons and lights from left to right are:

- **Cancel Button** – Press this button to cancel the current print job.
- **Print Cartridge Status Light** – When lit, the light above this symbol indicates that you need to check the status of your print cartridges. See “Print Cartridge Status” on page 42 for more information.
- **Resume Button and Light** – When this light flashes an action is needed such as load paper or clear a paper jam. To continue printing, press the Resume Button. See “What do the flashing lights mean?” on page 62.
- **Power Button and Light** – Use the Power Button to turn the printer on and off. After the Power Button is pressed, it takes approximately five seconds for the printer to power on. When the green light above the Power Button flashes, printing is in progress.
- **Infrared (Ir) Lens** – Use the infrared lens to print from an infrared sending device such as a Palm Pilot, laptop, or notebook computer. See “Infrared (Ir) Printing” on page 22. When the light to the right of the infrared lens displays a solid beam, the infrared device is transmitting information to the printer.

**Warning**

Always use the Power Button on the front of the printer to turn the printer on and off. Using a power strip, surge protector, or a wall-mounted switch to turn the printer on and off may cause premature printer failure.
Paper Trays

IN Tray

To print, place paper or other media types in the IN tray. Pull out the IN tray for easy loading. Be sure to slide the paper guides out of the way before loading the media print side down. Slide all media as far as it will go into the IN tray. Once you insert the media you want to use, slide the paper guides so they rest snugly against the media. Make sure the IN tray is pushed back in.

OUT Tray

The printer sends finished pages to the OUT tray.

OUT Tray Down – This is the typical position for most types of printing. The down position also allows single envelope printing. For information about printing on other media, see “Beyond the Basics” on page 30.

OUT Tray Up – The OUT tray must be in the up position to properly load banner paper and must remain in the up position to print banners.

OUT Tray Extension – The OUT Tray Extension should be pulled out when you are printing a large number of pages. In addition, it must be extended when you are printing in draft mode to prevent paper from falling to the floor. To use the OUT Tray Extension, gently pull out the extension. When your print job finishes, push the OUT Tray Extension back into its storage slot.

Note: Do not use the OUT Tray Extension with legal-sized paper. It may cause a paper jam.
How to Print

The printer is controlled through printer software (sometimes called a “printer driver”) that you install on your computer. The printer software provides a dialog box (like the one shown here) that you use to communicate with the printer. In the dialog box, you select settings such as paper size and type, orientation, and print quality.

- Windows 95, 98, 2000 or NT 4.0 users—see “How to Print in Windows 95, 98, 2000 and NT 4.0” on page 7.
- Windows 3.1x users—see “How to Print in Windows 3.1x” on page 11.
- DOS users—see “For DOS Users” on page 3.
How to Print in Windows 95, 98, 2000 and NT 4.0

Finding the HP Printer Properties Dialog Box

How you find the HP Printer Properties dialog box depends on the software program and operating system that you are using. Since each software program is different, the dialog box that appears on your screen may differ from those shown here. One of the following methods will surely get you to the HP Printer Properties dialog box.

**From your software program, try this:**

**Note:** When you see ➔, it means to find and click the word that follows.

1. **Click File ➔ Print.**

   ![Click File and then click Print.](image)

   Click File to open the HP Printer Properties dialog box.

2. Your software program opens a Print dialog box, similar to the previous example. From the Print dialog box, click whichever button you see—Properties, Setup, or Printer. The HP Printer Properties dialog box opens.

   **Or try this:**

1. If you don’t see a Print option in the File menu, click File ➔ Printer Setup or File ➔ Print Setup.

   ![Click File and then click Printer Setup.](image)

2. From the Printer Setup or Print Setup dialog box, click Setup or Options.
HP Printer Properties Dialog Box

There are three tabs located in the Printer Properties dialog box. Once you’ve opened this box, simply click a tab, then choose your settings.

- Setup (see page 8)
- Features (see page 9)
- Advanced (see page 10)

Setup Tab
(Windows 95, 98, 2000 and NT 4.0)

Print Quality
- Draft - Quick printing
- Normal - Every day printing
- Best - Highest quality printing

Paper Type
Choose from a wide range of paper types. The Automatic option (the default setting) allows the printer’s optical sensor to detect the type of media that has been loaded and to automatically determine the paper type.

Paper Size
Choose a paper size or enter a custom size.

Click here to resize an image if it’s too large to fit on the specified paper size.

Click here to print banners.

Photo Paper Printing
If you manually select an HP Photo Paper (or any other photo paper), the Photo Paper Printing options become available.
- Click PhotoREt to automatically select the best configuration of print speed and quality.
- Click 2400x1200 dpi for source images greater than 600 dpi. This setting requires 400 MB or more hard disk space and takes longer to print.

If you choose Automatic as the paper type, the Photo Paper Printing options are not available.

Look here to see the results of your current settings.
Features Tab
(Windows 95, 98, 2000 and NT 4.0)

Choose the best page orientation.
- Click Portrait for vertical page layout.
- Click Landscape for horizontal page layout.
- Click Mirror Image to reverse the printed image.

Click here to select Two-Sided Printing, then choose a method:
- Book — binding on the side.
- Tablet — binding on the top.
Click Automatic when using the Automatic Two-Sided Printing Module.

Click here to print multiple pages per sheet. Choose:
- Two or four pages per sheet.
- To print a border around each page on the sheet.

Click here to print the last page of your document first.

Look here to see the results of your current settings.

Click here and choose the size of your poster by selecting the number of pages across and down.

Click here to view the effects of all selected settings for your document before you print. Show HP Preview will allow you to print, cancel, or create a graphic file of your document. You can change some print settings, visually see the effects, and print with the new settings.

To preview the document after selecting this option, click OK and then click OK in the Print dialog box.
Advanced Tab  
(Windows 95, 98, 2000 and NT 4.0)

Choose appropriate color options.
- Click here to print in shades of gray.
- High Quality provides optimal print quality for grayscale printing.
- Black only provides faster grayscale printing by using only the black pen (not recommended for use with glossy paper).
- Optimize for Photocopy or Fax (not available when printing in grayscale).
- Automatic Image Enhancement sharpens images and provides contrast optimization.

Slide to adjust the amount of ink on the page.
Click Low Memory Mode to enable faster printing by using less computer memory (unavailable when 2400 x 1200dpi is selected on the Setup tab).

The standard buttons at the bottom of every Printer Properties dialog box are shown here.

Cancel — Cancels your changes and closes the dialog box.

OK — Accepts your changes and closes the dialog box.

Apply — Applies your changes.

Factory Settings — Returns all of the tab settings to the factory defaults.

Help — Displays a message telling you to click your right mouse button for help.
How to Print in Windows 3.1x

Note: Windows 3.1x is not supported in Japan.

Use your printer software to control how and what you print. Print quality, paper size and type, and two-sided printing are just a few of the options available to you in the HP DeskJet 990C Printer Properties dialog box.

Note: Not all printing features available to Windows 95, 98, 2000, and NT 4.0 users are available to 3.1x users.

HP Printer Properties Dialog Box

1. Click File ➔ Print from the software program you are using. Your software program opens a Print dialog box.

2. From the Print dialog box, click whichever button you see—Properties, Setup, or Printer. The HP DeskJet 990C Series Printer Properties dialog box opens.

The four tabs located in the HP DeskJet 990C Series dialog box are:

- Setup (see page 12)
- Features (see page 12)
- Color (see page 13)
- Services (see page 13)

Simply click a tab, then choose your options.

The standard buttons at the bottom of the HP DeskJet 990C Series dialog box are:

- Default – Returns all of the tab settings to the factory defaults.
- OK – Accepts your changes and closes the dialog box.
- Cancel – Cancels your changes and closes the dialog box.
- Help – Displays help information.
Printing Basics: How to Print in Windows 3.1x

Setup Tab (Windows 3.1x)

Print Quality
- **Best** - Highest quality printing
- **Normal** - Every day printing
- **EconoFast** - Quick printing

Click Cut Sheet for separated pieces of paper.

Features Tab (Windows 3.1x)

Two-sided Printing
- **None** — single-sided printing (default)
- **Book** — binding on the side.
- **Tablet** — binding on the top.

Choose the best page orientation.
- Click **Portrait** for vertical page layout.
- Click **Landscape** for horizontal page layout.

Click Flip Horizontal to reverse the printed image.

Click here to print the last page of your document first.

Choose a paper size from the menu.
Click here to select from a wide range of paper types.
Click here to print banners.

Click here to choose:
- Number of pages printed per sheet.
- To print a border on each page on the sheet.

Choose the size of your poster by selecting the number of pages across and down.

Choose the number of copies to print.
Printing Basics: HP DeskJet Toolbox

**Color Tab** *(Windows 3.1x)*

Choose Automatic to use the system’s default ColorSmart II settings.

Choose Manual, then Options to adjust color intensity.

Click here to print in shades of gray.

**Services Tab** *(Windows 3.1x)*

Use the Services tab to perform routine printer maintenance.

Click the button related to the maintenance task you want to do.

---

**HP DeskJet Toolbox**

**Windows 95, 98, 2000, and NT 4.0**

Use the HP DeskJet Toolbox for cleaning and calibrating your printer, finding information, and printing a test page.

- Click Start ➔ Programs ➔ HP DeskJet 990C Series ➔ HP DeskJet 990C Series Toolbox.
- Right-click the Printer Settings taskbar icon and choose Open Toolbox. See “Printer Settings Taskbar Icon” on page 16.

The HP Toolbox has four tabs.

- Printer Services
- Estimated Ink Level
- Configuration
Toolbox Tabs
(Windows 95, 98, 2000 and NT 4.0)

Click the Printer Services tab to:
• Open the electronic User’s Guide.
• Calibrate the printer when color and black ink aren’t aligned.
• Clean the print cartridges when lines and dots are missing from what you have printed.
• Check for clarity after cleaning by printing a Test Page.
• Check for printer problems by printing a Diagnostics Page.

If you are using a parallel cable, you can enable hardware ECP on the Configuration tab. When you check Attempt to Use Hardware ECP, photos may print more quickly.

Click the Estimated Ink Level tab to:
• Present a visual display of the black and color cartridge ink level.
• Show the print cartridge part numbers.
• View print cartridge ordering information.
Windows 3.1x

Note: Windows 3.1x is not supported in Japan.

Use the HP DeskJet 990C Toolbox for finding information and maintaining your printer. The HP DeskJet Toolbox is installed in the HP DeskJet Utilities group in the Program Manager. The Toolbox has two tabs: How Do I? and Printer Services. You can also access Printer Services from the HP DeskJet 990C Series Printer Properties dialog box (see page 13). Simply click a tab, then choose an option.

How Do I?

Click a button to read instructions on:
- Replacing the print cartridges
- Loading paper
- Changing print settings
Printer Settings Taskbar Icon

Note: The Printer Settings taskbar icon is not available in Windows 3.1x.

Use the Printer Settings taskbar icon to determine the state of the printer, such as print cartridge status, and to adjust print settings, such as default print quality and automatic two-sided printing. The Printer Settings taskbar icon appears at the end of the taskbar.

Warning Message Indicator

The outline color of the Printer Settings taskbar icon indicates whether or not print cartridge warning messages have been issued.

When the icon is:

- Outlined in yellow and blinking, print cartridge warning messages need to be checked.
- Outlined in yellow and not blinking, previously checked print cartridge warning messages are pending. Once the warning issues are resolved, the icon outline disappears.

Determining the Number of Pending Warning Messages

- Position the pointer over the Printer Settings taskbar icon.

A text box displays the name of your printer and indicates if any warning messages are pending. To view the warning messages see “Displaying Print Cartridge Warning Messages” on page 18.
Opening the Default Print Settings Dialog Box

1 Click the Printer Settings taskbar icon.

The Default Print Settings dialog box is displayed. This box allows you to change the default print quality of future documents and to turn on automatic two-sided printing. For information on these topics, see “How to Print” on page 6 or “Automatic Two-Sided Printing” on page 20.

Or try this: Right-click the Printer Settings taskbar icon. In the shortcut menu that appears, click Change Default Print Settings.

2 Select from the available options.

3 When finished, click anywhere outside the dialog box.

A dialog box indicates that this feature allows you to change the print settings used every time you print.

Note: If you do not want to see this dialog box in the future, click Don't show me this message again. If you want to redisplay it again later on, open the Toolbox, go to the Configuration tab, and click Display Printer Settings Confirmation. See “HP DeskJet Toolbox” on page 13.

4 Click OK.
Displaying Print Cartridge Warning Messages

1. Click the Printer Settings taskbar icon to open the Default Print Settings dialog box.

2. At the bottom of the dialog box, click the Warning Information button.

The HP DeskJet Toolbox is displayed. The Warning Information tab displays any warning messages for your printer.

3. When finished viewing the messages, in the top-right corner of the Toolbox, click the Close button.

Opening the Printer Properties Dialog Box

1. Double-click the Printer Settings taskbar icon.

   The Printer Properties dialog box is displayed. For more information on this dialog box, see “HP Printer Properties Dialog Box” on page 8.

2. When finished with the dialog box, click OK.

Printer Settings Taskbar Icon Shortcuts

1. Right-click the Printer Settings taskbar icon.

   A shortcut menu appears.

<table>
<thead>
<tr>
<th>Change Default Print Settings</th>
<th>Open Toolbox</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ HP DeskJet 990C Series</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
</tr>
</tbody>
</table>

   The menu displays the names of most installed printers. A check mark appears next to the selected printer.

2. If you want to work with a different printer, select that printer from the menu.
Choose one of the following:

- **Change Default Print Settings** to display the Default Print Settings dialog box.
- **Open Toolbox** to display the HP DeskJet Toolbox. For more information on this box, see “HP DeskJet Toolbox” on page 13.
- **Exit** to turn off the Printer Settings taskbar icon.

---

### Automatic Paper-Type Sensor

**Note:** The Automatic Paper-Type Sensor is not supported in Windows 3.1x.

When you use the Automatic Paper-Type Sensor, your HP DeskJet 990C can automatically determine the correct paper type for most paper or media placed into the printer’s IN tray. This feature, especially when used with HP paper and media, can help you get the best printing results.

**Note:** This feature is not recommended for printed or lined paper and media.

### How to Use the Automatic Paper-Type Sensor

1. Open the **HP Printer Properties** dialog box. For more information, see “Finding the HP Printer Properties Dialog Box” on page 7.

2. Click the **Setup** tab.

3. In the **Paper Type** box, make sure **Automatic** is selected.

   **Note:** Automatic is the default paper type setting.
4 Select from the other printer settings as necessary.

**Note:** When using the Automatic paper type setting, the print quality setting is automatically set to Normal. If you wish to use a different print quality, you can manually change this setting. For more information, see “How to Print” on page 6.

5 Click OK.

As the printer begins to pull in the first page, an optical sensor (a blue light) quickly scans the page one or more times to determine the best paper type setting. This takes only a few seconds. After the paper type is determined, printing begins.

**Note:** The Automatic Paper-Type Sensor only scans the first page of each new print job.

**Note:** The Automatic Paper-Type Sensor works with both HP and non-HP media. However, it is optimized for HP media so your printer can quickly select the appropriate paper type. For a complete list of HP products, see “Paper and Other Media” on page 89.

**Note:** You can turn off the Automatic Paper-Type Sensor. In the Paper Type box of the **Setup** tab, select a paper type other than Automatic.

---

**Automatic Two-Sided Printing**

**Note:** The Automatic Two-Sided Printing Module is not supported in Windows 3.1x.

The Automatic Two-Sided Printing Module is a special hardware and software feature that enables your printer to automatically print on both sides of the page.

**Installing the Automatic Two-Sided Printing Module**

1 Turn the knob on the printer’s Rear Access Door counterclockwise, and remove the door.
2 Insert the module into the back of the printer.

Printing with the Automatic Two-Sided Printing Module

1 Load the appropriate paper.

   Note: Not all paper types work with the Automatic Two-Sided Printing Module. You can print on plain paper, HP Bright White Inkjet Paper, HP Premium Inkjet Heavyweight Paper, HP Felt-textured Greeting Card Paper, HP Professional Brochure Paper, Glossy or Matte, and HP Photo Quality InkJet Paper, Semi-gloss or Matte. Not all paper weights and sizes can be used with the Automatic Two-Sided Printing Module.

2 Open the HP Printer Properties dialog box. For more information, see “Finding the HP Printer Properties Dialog Box” on page 7.

3 On the Features tab:
   a. Check Two-Sided Printing.
   b. Make a selection, then click OK.
   c. Select Book or Tablet as the page orientation.
   d. Make sure Automatic is selected.

4 Click OK.

5 Click OK in the Print dialog box.

   Note: After one side of the page is printed, the paper is held while the ink dries. Once the ink is dry, the paper is pulled back in, and the reverse side is printed. As each page is finished, the page drops into the OUT tray.

   Note: If you have problems with Two-Sided Printing, see page 71.
Infrared (Ir) Printing

Infrared (Ir) connectivity is a feature that enables wireless connectivity for personal digital assistants (PDAs), laptop or notebook computers, and other mobile devices. Use the Infrared feature to print to the HP DeskJet 990C from an infrared device such as a laptop or Palm device without any type of connecting cable. The 990C printer includes an infrared lens that can access and print information sent to it by another infrared device.

Supported Operating Systems

Some of the operating systems supported by infrared include:

- Windows 2000
- Windows 98
- Windows CE
- Palm

Supported Devices

Some of the devices supported by infrared include:

- Laptop or notebook computers with infrared capability (including the HP Omnibook)
- Some Personal Digital Assistants (including the Palm product line)
- Some Windows CE devices (including the HP Jornada)
- Digital cameras with infrared capability and the JetSend program (including the HP PhotoSmart)
- Some cellular phones with infrared capability

Note: To determine if a specific device is supported by infrared, check the manufacturer’s reference guide.
Using Infrared with a Laptop or Notebook running Windows 98

Setting up a Laptop or Notebook for Infrared

To configure a laptop or notebook for infrared communication, you may need to make changes to your computer’s BIOS settings. The procedures for configuring a computer for infrared vary, depending on the specific device. For instructions on configuring your particular laptop or notebook, refer to one of the following:

- Reference guide or instructions that came with the device
- Device manufacturer’s web site or support telephone number
- Infrared Data Association (IrDA) web site at: http://www.irda.org

Enabling Infrared

1. Click Start ➔ Settings ➔ Control Panel.

   The Control Panel window is displayed.

2. Double-click the Infrared icon.

   The Infrared Monitor dialog box is displayed.

   ![Infrared Monitor Dialog Box]

**Note:** If the Infrared icon in the Control Panel is not available, you must load the Infrared driver and/or configure the computer for infrared. The Infrared driver can be found on the Microsoft Windows 98/2000 software CD or downloaded from the Microsoft web site at http://www.microsoft.com.

**Or try this:** Click the Infrared icon at the end of the taskbar (if it’s displayed).
3 Click the Options tab.

4 Click to select Enable infrared communication.

5 Click OK.

The Infrared icon at the end of the taskbar should look like . It indicates that infrared is enabled.

Note: If the Infrared icon is not displayed on the taskbar, see “Displaying the Infrared Icon on the Taskbar” on page 25.

Preparing to Print
1 Click Start ➔ Settings ➔ Printers.
   The Printers window is displayed.
2 Right-click the HP DeskJet 990C Series printer.
   The Properties dialog box is displayed.
4 Click the Details tab.
5 In the Print to the following port box, choose one of the following:
   - LPTx: (Infrared Printing (LPT) Port)
     This is typically the LPT3 port.
   OR
   - COMx: (Infrared Serial (COM) Port)
     This is typically the COM4 port.
6 Click OK.
Printing Basics: Infrared (Ir) Printing

Printing using Infrared

1 Locate the infrared lens on the laptop or notebook. This is typically found on one of the sides of the computer.

2 Align the computer’s infrared lens with the printer’s infrared lens. Position the computer up to 3 feet (1 meter) from the printer and within a 30-degree total angle from the printer’s infrared lens.

   **Note:** The path between the two infrared devices must be clear of obstacles.

   When the two infrared devices are lined up correctly, the infrared light on the printer will begin to blink. This indicates that a connection has been established between the two devices.

3 Send a file to print following the normal printing procedures. See “How to Print” on page 6.

   The infrared light on the printer displays a solid beam during the transfer process. When finished printing, the light will begin to blink again.

   If the Infrared Monitor is displayed, the Status tab indicates the progress of the infrared activity as the printer receives and prints the file.

   **Note:** If the laptop or notebook is moved out of range of the printer’s infrared lens at any time during the printing process, the infrared light will turn off and the printer may stop printing. If you realign the devices within approximately 3–30 seconds (depending on the laptop or notebook), the print job will resume.

Displaying the Infrared Icon on the Taskbar

The Infrared icon on the taskbar typically appears after your computer is configured for infrared. If the icon is not displayed on your taskbar, you can quickly turn it on.

1 Click Start ➔ Settings ➔ Control Panel.

   The Control Panel window is displayed.

2 Double-click the Infrared icon.

   The Infrared Monitor dialog box is displayed.
3 Click the Preferences tab.

4 Click to select Display the Infrared Monitor icon on the taskbar.

5 Click OK.

Printing using a Palm Pilot

1 Locate the infrared lens on the Palm Pilot. This is typically found on the top edge of the Palm Pilot.

2 Align the Palm Pilot’s infrared lens with the printer’s infrared lens. Position the Palm Pilot up to 3 feet (1 meter) from the printer and within a 30-degree total angle from the printer’s infrared lens.

Note: The path between the two infrared devices must be clear of obstacles.

3 Do one of the following:

- Use the Beam command to send a single calendar appointment, or one or more business cards, to-do list items, or memos to the printer.

- Use the Print command to send one or more items (such as calendar appointments, e-mail messages, phone lists, or to-do lists) to the printer.

Note: Printing (rather than beaming) requires a printing program. A printing program can greatly enhance the appearance of your printed information. When printing, follow the specific procedures of the program.
The infrared light on the printer displays a solid beam during the transfer process. When finished printing, the light will turn off.

**Note:** If the Palm Pilot is moved out of range of the printer’s infrared lens at any time during the printing process, the infrared light will turn off and the printer may stop printing. If you realign the devices within approximately 3–30 seconds (depending on the device), the print job will resume.

**Printing using an HP PhotoSmart Digital Camera**

1. Locate the infrared lens on the digital camera.
   - This is typically found on the front of the camera.

2. Align the camera’s infrared lens with the printer’s infrared lens.
   - Position the camera up to 3 feet (1 meter) from the printer and within a 30-degree total angle from the printer’s infrared lens.

   **Note:** The path between the two infrared devices must be clear of obstacles.

3. Send a photo to print following the normal sending or sharing procedures of the camera.
   - The infrared light on the printer displays a solid beam during the transfer process. When finished printing, the light will turn off.

   **Note:** If the digital camera is moved out of range of the printer’s infrared lens at any time during the printing process, the infrared light will turn off and the printer may stop printing. If you realign the devices within approximately 3–30 seconds (depending on the device), the print job will resume.
Printing Basics: Infrared (Ir) Printing

Printing using a Windows CE Device

1. Locate the infrared lens on the Windows CE device.
   This is typically found on one of the sides of the device.

2. Align the infrared lens of the Windows CE device with the printer’s infrared lens. Position the Windows CE device up to 3 feet (1 meter) from the printer and within a 30-degree total angle from the printer’s infrared lens.

   **Note:** The path between the two infrared devices must be clear of obstacles.

3. In the program from which to print, click **File ➔ Print**.

4. In the **Printer** box, choose either PCL Inkjet or JetSend (if installed).

   **Note:** The JetSend program can greatly enhance the appearance of your printed information. For information on JetSend, go to the following web site: [http://www.jetsend.com](http://www.jetsend.com).

5. In the **Port** box, choose IRDA.

6. Click **OK**.

   The infrared light on the printer displays a solid beam during the transfer process. When finished printing, the light will turn off.

   **Note:** If the Windows CE device is moved out of range of the printer’s infrared lens at any time during the printing process, the infrared light will turn off and the printer may stop printing. If you realign the devices within approximately 3–30 seconds (depending on the device), the print job will resume.
Printer Maintenance Tips

Because the printer ejects ink onto the paper in a fine mist, ink smudges will eventually appear on the printer case. To remove smudges, stains, and/or dried ink from the exterior of the printer, use a soft cloth moistened with water.

When cleaning your printer, keep these tips in mind:

- **Do not** clean the interior of the printer. Keep all fluids away from the interior.
- **Do not** use household cleaners or detergent. In the event that a household cleaner or detergent is used on the printer, wipe the printer’s exterior surfaces with a soft cloth moistened with water.
- **Do not** lubricate the print cartridge support rod. Noise is normal when the print cartridge cradles slide back and forth.

For information on cleaning print cartridges and the print cartridge cradle, see page 46.

**Caution**  
*For maximum performance and reliability, the printer should be handled and stored in an upright, level position.*
Beyond the Basics

Getting the Right Paper

Most plain photocopy paper works fine in your printer, particularly paper that is marked for use in inkjet printers. To get the best results, use one of the Hewlett-Packard papers, which were developed especially for HP inks and your printer.

**Brightness.** Some papers are whiter than others and produce sharper, more vibrant colors. For photographs, you’ll want to use HP Premium Plus Photo Paper or HP Premium Photo Paper for the best results. For projects that use other colored images, HP Bright White Inkjet or HP Premium Inkjet paper work well.

For a complete list of available HP media, see “Paper and Other Media” on page 89.

For information on supported paper weights and sizes, see “Media Weight” and “Media Size” on page 82.

Printing on Different Types of Paper and Media

Your printer is designed to encompass so many different types of print media that you’re practically set up as a small print shop. This chapter explains how to use the different printing materials.

When asked to open the HP Printer Properties dialog box, refer to the appropriate section for your operating system in this guide:

- Windows 95, 98, 2000 or NT 4.0 users—see “How to Print in Windows 95, 98, 2000 and NT 4.0” on page 7.
- Windows 3.1x users—see “How to Print in Windows 3.1x” on page 11.
Manual Two-Sided Printing

I should... | Then... | Guidelines...
---|---|---
**Book Binding**
1. Remove all paper from the OUT tray.
2. Load paper into the IN tray.
3. Slide the paper guides snugly against the sheets.
4. Push in the IN tray.
5. Open the HP Printer Properties dialog box (see page 7).

6. Choose HP Print Settings.
   **Setup Tab**
   - **Paper Type:** Choose either Automatic or the appropriate paper type
   - **Print Quality:** Choose the appropriate print quality
   - **Paper Size:** Choose appropriate size

   **Features Tab**
   - **Orientation:** Choose appropriate orientation
   - **Two-Sided Printing:** Check this box. In the content size box, click Cancel. Choose Book or Tablet as the paper orientation. Clear the Automatic check box.

   Check Two-Sided Printing, then select Book or Tablet.

7. Begin printing.
8. Carefully follow the reloading instructions displayed on your computer screen.
9. When the paper is properly reloaded, click Continue.

**Guidelines...**
- Manual Two-Sided Printing can be done using either the Rear Access Door or the attached Automatic Two-Sided Printing Module.
- The printer automatically prints the odd-numbered pages first. Then, a message appears on your computer screen telling you how to reload the paper in order to print the even-numbered pages.
### Beyond the Basics: Printing Transparencies

<table>
<thead>
<tr>
<th>I should...</th>
<th>Then...</th>
<th>Guidelines...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pull out the IN tray.</td>
<td>Choose HP Print Settings. Setup Tab</td>
<td>For best results, use HP Premium Inkjet Transparency Film.</td>
</tr>
<tr>
<td>Slide out both of the paper guides, and remove all paper from the IN tray.</td>
<td>• Paper Type: Choose either Automatic or the appropriate transparency type</td>
<td></td>
</tr>
<tr>
<td>Fan the edges of the transparency sheets to separate them, then align the edges.</td>
<td>• Print Quality: Choose Draft, Normal, or Best.</td>
<td></td>
</tr>
<tr>
<td>Insert a stack of up to 25 transparency sheets, rough side down and the adhesive strip towards the printer.</td>
<td>• Paper Size: Choose appropriate size</td>
<td></td>
</tr>
<tr>
<td>Slide the paper guides snugly against the transparencies.</td>
<td>Features Tab</td>
<td></td>
</tr>
<tr>
<td>Push in the IN tray</td>
<td>• Orientation: Choose appropriate orientation</td>
<td></td>
</tr>
<tr>
<td>Open the HP Printer Properties dialog box (see page 7).</td>
<td>• Two-Sided Printing: Unchecked</td>
<td></td>
</tr>
<tr>
<td>8 Print the transparencies.</td>
<td>9 The printer waits for transparencies to dry before releasing them automatically. Press the Resume Button to continue printing.</td>
<td></td>
</tr>
</tbody>
</table>
### Printing Single Envelopes

<table>
<thead>
<tr>
<th>I should...</th>
<th>Then...</th>
<th>Guidelines...</th>
</tr>
</thead>
</table>
| ![Image](image) | 1. Slide the envelope, with its flap side on the left and flap facing up, into the single envelope slot. Push the envelope in until it stops.  
2. Open the HP Printer Properties dialog box (see page 7). |  - Make sure the OUT tray is in the down position.  
- Avoid envelopes that have clasps or windows.  
- Avoid envelopes that are shiny or embossed, envelopes with thick, irregular, or curled edges, or envelopes that are wrinkled, torn, or otherwise damaged.  
- If your software program includes an envelope-printing feature, follow those instructions instead of the procedure here. |

3. Choose HP Print Settings.  
   **Setup Tab**  
   - **Paper Type**: Choose either Automatic or Plain Paper  
   - **Print Quality**: Choose Normal  
   - **Paper Size**: Choose appropriate envelope size  
   **Features Tab**  
   - **Orientation**: Choose appropriate envelope orientation  
   - **Two-Sided Printing**: Unchecked  

4. Print the envelope.
Printing a Stack of Envelopes

<table>
<thead>
<tr>
<th>I should...</th>
<th>Then...</th>
<th>Guidelines...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Pull out the IN tray.</td>
<td>7 Choose HP Print Settings. <strong>Setup Tab</strong>&lt;br&gt;- <strong>Paper Type:</strong> Choose either Automatic or Plain Paper&lt;br&gt;- <strong>Print Quality:</strong> Choose Normal&lt;br&gt;- <strong>Paper Size:</strong> Choose appropriate envelope size</td>
<td><strong>Never</strong> load more than 15 envelopes at one time.</td>
</tr>
<tr>
<td>2 Slide out both of the paper guides and remove all paper from the IN tray.</td>
<td><strong>Features Tab</strong>&lt;br&gt;- <strong>Orientation:</strong> Choose appropriate envelope orientation&lt;br&gt;- <strong>Two-Sided Printing:</strong> Unchecked</td>
<td>Align the envelope edges before inserting them.</td>
</tr>
<tr>
<td>3 Slide up to 15 envelopes, with their flap side on the left and flap facing up, into the IN tray as far as they will go.</td>
<td>8 Print the envelopes.</td>
<td>Avoid envelopes that have clasps or windows.</td>
</tr>
<tr>
<td>4 Slide the paper guides snugly against the edges of the envelopes.</td>
<td></td>
<td>Avoid envelopes that are shiny or embossed, envelopes with thick, irregular, or curled edges, or envelopes that are wrinkled, torn, or otherwise damaged.</td>
</tr>
<tr>
<td>5 Push in the IN tray.</td>
<td></td>
<td>If your software program includes an envelope-printing feature, follow those instructions instead of the procedure here.</td>
</tr>
<tr>
<td>6 Open the HP Printer Properties dialog box (see page 7).</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Beyond the Basics: Printing a Stack of Envelopes**
### Beyond the Basics: Printing Business Cards, Index Cards, and Other Small Media

**Printing Business Cards, Index Cards, and Other Small Media**

<table>
<thead>
<tr>
<th>I should...</th>
<th>Then...</th>
<th>Guidelines...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Pull out the IN tray.</td>
<td>7 Choose HP Print Settings. <strong>Setup Tab</strong>&lt;br&gt;• <strong>Paper Type</strong>: Choose either <strong>Automatic</strong> or the appropriate paper type&lt;br&gt;• <strong>Print Quality</strong>: Choose <strong>Draft</strong>, <strong>Normal</strong>, or <strong>Best</strong>&lt;br&gt;• <strong>Paper Size</strong>: Choose appropriate media size</td>
<td>• Align the media edges before inserting the media.</td>
</tr>
<tr>
<td>2 Slide out both paper guides and remove all paper from the IN tray.</td>
<td><strong>Features Tab</strong>&lt;br&gt;• <strong>Orientation</strong>: Choose appropriate orientation&lt;br&gt;• <strong>Two-Sided Printing</strong>: Unchecked</td>
<td>• For ease of loading small media, pull out the IN tray and raise the OUT tray. After you have inserted the media, lower the OUT tray.</td>
</tr>
<tr>
<td>3 Insert up to 45 cards or other small media into the IN tray as far as they will go.</td>
<td>8 Print.</td>
<td>• If you get an “out of paper” message, make sure the media is positioned properly in the IN tray. Place the media on the right side and towards the printer. The IN tray should be pushed in so that the paper length guide can hold the media in place.</td>
</tr>
<tr>
<td>4 Push the paper length guide in as far as it will go. Push the fine-length guide (colored portion of paper length guide) snugly against the media. Then push the paper width guide in.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5 Push in the IN tray.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6 Open the HP Printer Properties dialog box (see page 7).</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Printing Labels

<table>
<thead>
<tr>
<th>I should...</th>
<th>Then...</th>
<th>Guidelines...</th>
</tr>
</thead>
</table>
| 1. Pull out the IN tray. | 8. Choose HP Print Settings. **Setup Tab**  
- **Paper Type**: Choose either Automatic or Plain Paper  
- **Print Quality**: Choose Normal  
- **Paper Size**: Choose A4 or Letter (8.5 x 11 in.)  
**Features Tab**  
- **Orientation**: Choose appropriate orientation  
- **Two-Sided Printing**: Unchecked | • Use only paper labels that are designed specifically for use with inkjet printers.  
• Never load more than 20 sheets at one time.  
• Use only full sheets of labels.  
• Make sure the sheets are not sticky, wrinkled, or pulling away from their protective backing.  
• **Do not** use plastic or clear labels. The ink will not dry when used with plastic or clear labels. |
| 2. Slide out both of the paper guides, and remove all paper from the IN tray. | 9. Print the labels. |   |
| 3. Fan the edges of the label sheets to separate them, then align the label edges. | |   |
| 4. Insert up to 20 label sheets (label side down). | |   |
| 5. Slide the paper guides snugly against the sheets. | |   |
| 6. Push in the IN tray. | |   |
| 7. Open the HP Printer Properties dialog box (see page 7). | |   |
# Printing Photographs

<table>
<thead>
<tr>
<th>I should...</th>
<th>Then...</th>
<th>Guidelines...</th>
</tr>
</thead>
</table>
| 1 Pull out the IN tray. | 7 Choose HP Print Settings.  
   Setup Tab  
   - **Paper Type**: Choose either Automatic or a photo paper  
   - **Photo Paper Printing** (available when a specific photo paper is selected as the paper type): Click **PhotoREt** to automatically select the best combination of print speed and quality.  
   **OR**  
   Click **2400 x 1200 dpi** for source images greater than 600 dpi (requires 400 MB or more hard disk space and takes longer to print).  
   ![Photo Settings](image)  
   **Note**: Photo Paper Printing options are not available in Windows 3.1x.  
   - **Paper Size**: Choose appropriate paper size  
   - **Orientation**: Choose appropriate orientation  
   - **Two-Sided Printing**: Unchecked | 8 Print the photo.  
   - For best results use an HP photo paper.  
   - The photo needs to be in electronic (digital) form, before you can print it. Take a digital picture, scan a photo, or have your local camera shop provide an electronic file of your photo.  
   - Use PhotoREt for most photo paper printing.  
   - After selecting your paper type, choose the appropriate paper size from the pull-down menu.  
   - If you have a parallel cable, you may be able to increase photo printing speed by enabling Hardware ECP. Open the HP DeskJet Toolbox. Click the Configuration tab and check **Use Hardware ECP**. Apply your changes and print your photo. |
| 2 Slide out both of the paper guides, and remove all paper from the IN tray. | 3 Insert up to 20 sheets of photo paper (printable side down) into the IN tray.  
   4 Slide the paper guides snugly against the edges of the media.  
   5 Push in the IN tray.  
   6 Open the HP Printer Properties dialog box (see page 7). |  |
I should…

1. Pull out the IN tray.
2. Slide out both paper guides and remove all paper from the IN tray.
3. Insert up to 5 cards into the IN tray as far as they will go.
4. Slide the paper guides snugly against the edges of the cards.
5. Push in the IN tray.
6. Open the HP Printer Properties dialog box (see page 7).

Then…

7. Choose HP Print Settings.
   - **Setup Tab**
     - **Paper Type**: Choose either Automatic or the appropriate greeting card type
     - **Print Quality**: Choose Normal or Best
     - **Paper Size**: Choose appropriate card size
   - **Features Tab**
     - **Orientation**: Choose appropriate orientation
     - **Two-Sided Printing**: Choose if appropriate.
   - **Note**: If using Automatic Two-Sided Printing, you must use supported paper. See “Automatic Two-Sided Printing Module Specifications” on page 83.
8. Print.

Guidelines…

- Align the card edges before inserting the cards.
- For ease of loading small cards, pull out the IN tray and raise the OUT tray. After you have inserted the media, lower the OUT tray.
- If you have pre-folded greeting cards, unfold the cards, then load the cards into the IN tray.
- If you get an “out of paper” message, make sure the media is positioned properly in the IN tray. Place the media on the right side and towards the printer. The IN tray should be pushed in so that the paper length guide can hold the media in place.
### Beyond the Basics: Printing Iron-On Transfers

<table>
<thead>
<tr>
<th>I should...</th>
<th>Then...</th>
<th>Guidelines...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Pull out the IN tray.</td>
<td>7 Choose HP Print Settings.</td>
<td>• When you print a mirror-imaged document, the text and pictures are flipped horizontally from what you see on your computer screen.</td>
</tr>
<tr>
<td>2 Slide out both of the paper guides, and remove all paper from the IN tray.</td>
<td><strong>Setup Tab</strong>&lt;br&gt;- <strong>Paper Type</strong>: Choose either Automatic or HP Iron-On T-Shirt Transfers</td>
<td>• For best results, use HP Iron-On T-Shirt Transfers.</td>
</tr>
<tr>
<td>3 Load the iron-on transfer paper with printable side down.</td>
<td>- <strong>Print Quality</strong>: Choose Normal or Best</td>
<td></td>
</tr>
<tr>
<td>4 Slide the paper guides snugly against the sheets.</td>
<td>- <strong>Paper Size</strong>: Choose A4 or Letter (8.5 x 11 in.)</td>
<td></td>
</tr>
<tr>
<td>5 Push in the IN tray.</td>
<td><strong>Features Tab</strong>&lt;br&gt;- <strong>Orientation</strong>: Choose Mirror Image</td>
<td></td>
</tr>
<tr>
<td>6 Open the HP Printer Properties dialog box (see page 7).</td>
<td>- <strong>Two-Sided Printing</strong>: Unchecked</td>
<td></td>
</tr>
</tbody>
</table>

8 Print your transfer.
### Printing Posters

<table>
<thead>
<tr>
<th>I should...</th>
<th>Then...</th>
<th>Guidelines...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Load paper in the IN tray." /></td>
<td>1. Load paper in the IN tray.</td>
<td>• After printing, trim the edges on each sheet and tape the sheets together.</td>
</tr>
<tr>
<td><img src="image" alt="Slide the paper guides snugly against the sheets." /></td>
<td>2. Slide the paper guides snugly against the sheets.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Push in the IN tray." /></td>
<td>3. Push in the IN tray.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Open the HP Printer Properties dialog box (see page 7)." /></td>
<td>4. Open the HP Printer Properties dialog box (see page 7).</td>
<td></td>
</tr>
</tbody>
</table>
| | **5. Choose HP Print Settings.**  
**Setup Tab**  
- **Paper Type**: Choose either Automatic or Plain Paper  
- **Print Quality**: Choose Normal  
- **Paper Size**: Choose appropriate size  
**Features Tab**  
- **Orientation**: Choose appropriate orientation  
- **Two-Sided Printing**: Unchecked  
- **Poster Printing**: Check this box and choose size 2x2, 3x3, or 4x4 | |
| | 6. Print your poster. | |

Check **Poster Printing**, then choose size.
## Beyond the Basics: Printing Banners

### I should...  
- Tear off up to 20 sheets.
- Tear off and discard the perforated strips, if any.
- Pull out the IN tray.
- Slide out the paper guides, and remove all paper from the IN tray.
- Raise the OUT tray and leave it in the up position to print your banners.
- Slide the paper guides snugly against the sheets.
- Push in the IN tray.
- Open the HP Printer Properties dialog box (see page 7).

### Then...  
10 Choose HP Print Settings.  
**Setup Tab**  
- **Banner Printing:** Check this box  
- **Paper Type:** HP Banner Paper  
- **Print Quality:** Choose Normal  
- **Paper Size:** Choose either Banner [A4 (210 x 297 mm)] or Banner [Letter (8.5 x 11 in.)]  
**Features Tab**  
- **Orientation:** Choose appropriate orientation  
- **Two-Sided Printing:** Unchecked  
11 Print the banner.

### Guidelines...  
- When printing banners, be sure that the OUT tray is placed in the up position and the IN tray is pushed in.
- For best results, use HP Banner Paper.
- If you are having problems printing a banner, see “Banners aren’t printing correctly” on page 68.
- Depending on the software program you are using to print your banner, you may need to check the *HP DeskJet 990C Series Printer Release Notes* for specific printing information.
Print Cartridge Status

The Print Cartridge Status Light flashes when one or both of your print cartridges are low on ink, improperly installed, or malfunctioning. It will also flash if you are trying to use the wrong print cartridge type. If the problem is low ink, the light will stop flashing when you open the top cover. For any other print cartridge-related problem, the Print Cartridge Status Light will continue to flash.

To check the status of your print cartridges, open the printer’s top cover. The yellow arrow on the print cartridge cradle aligns with one of five Print Cartridge Status icons.
Print Cartridge Status continued

When the Print Cartridge Status Light flashes, open the printer’s top cover and follow the instructions below. For more information on replacing print cartridges, see page 44.

<table>
<thead>
<tr>
<th>If the arrow points to...</th>
<th>It means...</th>
<th>To solve the problem...</th>
</tr>
</thead>
</table>
| Problems with print cartridges | The print cartridge is either:  
• missing  
• improperly installed  
• the wrong print cartridge for the printer  
• defective | 1 Insert a print cartridge if it is missing.  
2 Remove and reinsert the existing print cartridge.  
3 If there is still a problem, verify that the color cartridge is an HP C6578 Series or HP No. 78 cartridge, and the black cartridge is an HP 51645 Series or HP No. 45 cartridge.  
4 If the problem persists, replace the cartridge. |
| Print cartridges low on ink | Color or black print cartridge is running low on ink. | • Consider replacing the color cartridge with an HP C6578 Series or HP No. 78 cartridge.  
• Consider replacing the black cartridge with an HP 51645 Series or HP No. 45 cartridge. |
| Print cartridges OK | Print cartridges are operational. | No problems. |
To Replace a Print Cartridge

1. To access the print cartridge cradle, make sure the OUT tray is down (1.1) and then press the Power Button (1.2) to turn on the printer.

2. Open the top cover. The cradle moves to an accessible position.

3. Raise the cradle latch.

4. Lift the print cartridge out and discard it.

Note: When buying replacement print cartridges, check the part numbers carefully. The print cartridge numbers for your printer are:

- Black HP 51645 Series or HP No. 45
- Tri-Color HP C6578 Series or HP No. 78

Note: When a print cartridge runs out of ink, leave the empty cartridge in the cradle until you can replace it. The printer does not print with only one print cartridge in the cradle.

Warning: Keep print cartridges out of the reach of children.
5 Remove the replacement print cartridge from its packaging and carefully remove the protective vinyl tape.

6 Push the print cartridge firmly, straight down into the print cartridge cradle.

7 Close the cradle latch. When the latch is fully closed, you will hear a click.

8 Load plain white paper in the IN tray.

9 Close the top cover, then a calibration page will print.

Note: Any time you install a new print cartridge, the printer software prints a calibration page to ensure your print quality. If you are in the middle of printing and stop to change a print cartridge, the software will wait until your printing has completed before it executes the calibration test.

10 If the Print Cartridge Status Light continues to blink after you install the new print cartridge, check the part number on the print cartridge to ensure you installed the correct one.

Warning: Do NOT touch the print cartridge ink nozzles or copper contacts. Touching these parts will result in clogs, ink failure, and bad electrical connections. Also, do NOT remove the copper strips; these are required electrical contacts.
Storing Print Cartridges

To maintain excellent print quality from your print cartridges:

- Keep all print cartridges in their sealed packages, at room temperature (60-78°F or 15.6-26.6°C), until you are ready to use them.
- Once installed, leave the print cartridges in their cradle at all times to keep them from drying out or becoming clogged.
- Store unsealed print cartridges in an airtight plastic container.
- **Do not** unplug the printer until printing is complete and the print cartridge cradles have returned to their home position on the right side of the printer. The print cartridges will dry out if not stored in their home position.
- Do not attempt to reattach the vinyl tape previously removed from the print cartridges. Reattaching the tape will damage the cartridges.

*Warning* Only use the Power Button on the front of the printer to turn the printer on and off. Using a power strip, surge protector, or a wall-mounted outlet switch to turn the printer on and off may cause premature failure.

Cleaning Print Cartridges

When Do You Need to Clean?

Clean the print cartridges if your printed page is missing lines or dots, or if it contains ink streaks.

If You See Missing Lines or Dots

Clean the print cartridges from the HP DeskJet Toolbox by doing the following:

1. Open the HP DeskJet Toolbox. For more information, see “HP DeskJet Toolbox” on page 13.
2. Click *Clean the Print Cartridges* and follow the on-screen directions.

*Note:* Unnecessary cleaning wastes ink and shortens the life of the print cartridge.
If You See Ink Streaks
Clean the print cartridges and the print cartridge cradle by following the instructions below.

1. Open the HP DeskJet Toolbox. For more information, see “HP DeskJet Toolbox” on page 13.

2. Click Clean the Print Cartridges and follow the on-screen directions. If this does not prevent streaks, follow the instructions for manually cleaning the print cartridges in the next section.

**Caution** Be careful not to get ink on your hands or clothing.

Manually Cleaning the Print Cartridges and Print Cartridge Cradle

In order to properly clean the print cartridges and cradle, you will need distilled or bottled water and cotton swabs or a similar lint-free absorbent material that will not stick to the cartridges.

1. Press the Power Button to turn the printer on, then lift the top cover.

2. After the print cartridges move into an accessible position, unplug the power cord from the back of the printer.

**Warning** Keep new and used print cartridges out of the reach of children.

3. Remove the print cartridges and set them on a piece of paper with the ink nozzle plate facing up.

**Caution** Do NOT touch the print cartridge ink nozzles or copper contacts. Touching these parts will result in clogs, ink failure, and bad electrical connection. Also, do NOT remove the copper strips; these are required electrical contacts.
4 Manually clean the print cartridges
   a. Dip a clean cotton swab into distilled water and squeeze any excess water from the swab.
   b. Clean the **face** and **edges** of the print cartridge as shown. **Do NOT** wipe the nozzle plate.
   c. Inspect the cartridge for fibers on the face and edges. If fibers are still present, repeat the cleaning process.
   d. Repeat the cleaning process for the other print cartridge.

   **Caution**: Once you’ve removed the print cartridges, make sure that they are not outside of the print cartridge cradle longer than 30 minutes.

5 Manually clean the print cartridge cradle.
   a. Using clean, moistened swabs, wipe the underside of each wall of the cradle.
   b. Repeat until no ink residue is seen on a clean swab.

6 Reinsert the print cartridges, then close the printer's top cover.
7 Load paper into the IN tray.
8 Reinsert the electrical power cord into the back of the printer.
9 Print a test page. From the **HP Toolbox**, click **Print a Test Page**.

**Note**: If streaking still appears, repeat the procedure until the test printout is clean. You will find additional maintenance tips at: [http://www.hp.com/go/support](http://www.hp.com/go/support).
Damage Resulting from Refilling the Print Cartridges

To get the best performance from your printer, Hewlett-Packard recommends using only genuine HP supplies for HP DeskJet printers, including genuine factory-filled HP print cartridges.

Damage resulting from the modification or refilling of HP print cartridges is specifically excluded from the coverage of HP printer warranties.

Note: When buying replacement print cartridges, check the part numbers carefully. The print cartridge numbers for your printer are:

- Black HP 51645 Series or HP No. 45
- Tri-Color HP C6578 Series or HP No. 78
Problems?

Troubleshooting Tips

It's frustrating when things go wrong, but the following pages contain tips that can help you determine what the problem is and how to fix it.

- Be sure cable connections are secure.
- Make sure that you are using the right cable for your operating system.
- Check if your question is similar to those listed here and then follow the instructions found in that section:

- What do the flashing lights mean? See pages 62–64.
- Is there a problem with your printout? See pages 65–70.
- Is there a problem with infrared (Ir) printing? See pages 73–74.
### Problems?: Troubleshooting Tips

**The printer software won’t install, what’s wrong?**

<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem...</th>
</tr>
</thead>
</table>
| I inserted a CD, but the computer couldn’t read it. | • The CD wasn’t properly inserted.  
**OR**  
• The CD player may be damaged.  
**OR**  
• The CD may be damaged. | 1. Reinsert the CD and try again. If this doesn’t solve your problem…  
2. Try inserting a CD that you know works. If that CD doesn’t work, you may need to replace your CD player.  
3. If other CDs work but the printer software CD doesn’t, you may have a damaged CD. You can download the printer software from an HP web site (see page 75 for web site addresses).  
4. If you don’t have Web access, contact HP Customer Care. See page 77, to locate the phone number nearest you. |
The printer software won’t install, what’s wrong?  *Continued*

<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem…</th>
</tr>
</thead>
<tbody>
<tr>
<td>The software did not install correctly.</td>
<td>• There may be a conflict with your virus protection program.</td>
<td>1  Uninstall your printer software.</td>
</tr>
<tr>
<td>OR You need to uninstall the printer software for any reason.</td>
<td>OR • There may be a conflict with another software program.</td>
<td><em>For Windows 95, 98, 2000, or NT 4.0</em></td>
</tr>
<tr>
<td></td>
<td>OR • There may be a conflict with a peripheral device connected to the printer.</td>
<td>a  Click Start ➔ Programs ➔ HP DeskJet 990C Series ➔ HP DeskJet 990C Series Uninstall.</td>
</tr>
<tr>
<td></td>
<td>OR • Your printer software didn’t install properly.</td>
<td>b  Follow the instructions that appear on your computer screen.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2  Close any software programs (including virus protection programs) that are running.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3  Disconnect any peripheral devices that use a parallel printer cable (such as a scanner or tape back-up system).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4  Reinstall the printer software. See the <em>Quick Start Poster</em>.</td>
</tr>
</tbody>
</table>
|                                              |                                                                               | If you are still having problems with the software installation, call an HP authorized dealer or HP Customer Care. For the phone number of the HP Customer Care Center nearest you, see page 77.
### Problems?: Troubleshooting Tips

#### The printer software won’t install, what’s wrong?  *Continued*

<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem...</th>
</tr>
</thead>
<tbody>
<tr>
<td>When I connect a USB cable between the printer and my computer, the “New Hardware Wizard” message did not appear.</td>
<td>You may not be using Windows 98 or 2000.</td>
<td>Make sure Windows 98 or 2000 is running and your computer is connected using a USB cable. If you do not have Windows 98 or 2000, you need to use a parallel cable.</td>
</tr>
<tr>
<td></td>
<td>Your USB cable may not be connected properly.</td>
<td>1  Disconnect and then reconnect the USB cable from your printer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2  Make sure that it is securely attached.</td>
</tr>
<tr>
<td></td>
<td>You may not have USB enabled.</td>
<td>1  In Windows 98 or 2000, click <strong>Start ➔ Settings ➔ Control Panel.</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2  Double-click the <strong>System</strong> icon.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3  Click the <strong>Device Manager</strong> tab.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4  Click the plus (+) icon next to the Universal Serial Bus Controller option. If you see a USB host controller and a USB root hub listed, USB is probably enabled. If you do not see these devices listed, refer to your computer’s documentation or contact the manufacturer for more information on enabling and setting up USB.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5  If you cannot enable USB, you can always use a parallel cable to connect your printer to your computer.</td>
</tr>
</tbody>
</table>
### The printer software won’t install, what’s wrong?  Continued

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible cause</th>
<th>Solution</th>
</tr>
</thead>
</table>
| When I connect a USB cable between the printer and my computer, the “New Hardware Wizard” message appeared once, but the printer did not install, and now “New Hardware Wizard” will not appear again. | Installation was cancelled or had an error. | 1. Select Start ➔ Settings ➔ Printers.  
2. Double-click on Add Printer.  
3. Click Next.  
4. Click Next.  
5. Click Have Disk.  
6. Click Browse, then browse to the printer software CD.  
7. Browse to the language code folder. For a list of language codes, see page 86.  
8. Double-click the Driver folder, and then click OK.  
9. Click OK.  
10. Click Next.  
11. In the list of ports you want to use with this printer, select USB/DeskJet 990C/<printer serial number>.  
12. Click Next.  
13. Click Next.  
14. Click Finish. |
### The printer software won’t install, what’s wrong? Continued

<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem…</th>
</tr>
</thead>
</table>
| When I connect a USB cable between the printer and my computer, an “Unknown device” message appears. | • Static electricity has built up in the cable between your computer and printer.  
  **OR**  
  • You may have a defective USB cable. | 1  Disconnect the USB cable from your printer.  
  2  Unplug the printer from its power cable.  
  3  Wait approximately 30 seconds.  
  4  Plug the power back into the printer.  
  5  Plug the USB cable back into the printer.  
  6  If “Unknown device” continues to appear in the “New hardware found” dialog box, replace the USB cable or use a parallel cable. |
<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem...</th>
</tr>
</thead>
<tbody>
<tr>
<td>No page came out of the printer.</td>
<td>Power may be off or there may be a loose connection.</td>
<td>1 Make sure the power is on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Make sure that all cable connections are secure.</td>
</tr>
<tr>
<td></td>
<td>You may not have any paper in the IN tray.</td>
<td>Double-check that the media is placed in the IN tray correctly.</td>
</tr>
<tr>
<td></td>
<td>The printer’s top cover may be open.</td>
<td>Close the printer’s top cover.</td>
</tr>
<tr>
<td></td>
<td>A problem may exist with one of the print cartridges.</td>
<td>If the Print Cartridge Status Light 🟢 is blinking, lift the printer’s cover, check the Print Cartridge Status. Verify that the print cartridges are installed properly. See page 44.</td>
</tr>
<tr>
<td></td>
<td>The printer may be slow.</td>
<td>If the Power Light ⚡ is blinking, the printer is in the process of printing. Be patient.</td>
</tr>
<tr>
<td></td>
<td>The printer is waiting for you to press the Resume Button 🚪.</td>
<td>If the Resume Light is flashing, press the Resume Button 🚪.</td>
</tr>
<tr>
<td></td>
<td>You may have chosen 2400 x 1200 dpi.</td>
<td>1 In Photo Paper Printing, select PhotoREt instead.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Print your document again.</td>
</tr>
</tbody>
</table>
### Why won’t it print?  *Continued*

<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem…</th>
</tr>
</thead>
<tbody>
<tr>
<td>No page came out of the printer. (continued)</td>
<td>There may be a paper jam and you are using the Rear Access Door.</td>
<td>1. Pull the paper out of either the IN tray or the OUT tray.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Press the Resume Button ( ) on the front of the printer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. If you were printing labels, make sure a label did not become unglued</td>
</tr>
<tr>
<td></td>
<td></td>
<td>from the label sheet while going through the printer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. If the paper jam has cleared, print your document again.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5. If the paper jam hasn’t cleared, open the Rear Access Door by turning</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the knob (counter-clockwise) and removing the door.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6. Pull the jammed paper out of the printer, then replace the Rear Access Door.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7. Print your document again.</td>
</tr>
<tr>
<td></td>
<td>There may be a paper jam in the Automatic Two-Sided Printing Module.</td>
<td>1. Turn your printer off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Press the button on top of the Automatic Two-Sided Printing Module and lower</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the access door.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Pull the jammed paper out of the Module, then close the access door.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Turn your printer back on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5. Print your document again.</td>
</tr>
</tbody>
</table>
### Why won’t it print? *Continued*

<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem...</th>
</tr>
</thead>
</table>
| No page came out of the printer.      | There is a paper jam in the back of the printer and the Automatic Two-Sided Printing Module is attached. | 1. Turn your printer off.  
2. Simultaneously press the release buttons, located on each side of the Automatic Two-Sided Printing Module, to remove the Module.  
3. Pull the jammed paper out of the printer, then replace the Module (see page 20).  
4. Turn your printer back on.  
5. Print your document again. |
|                                      | The Rear Access Door or the Automatic Two-Sided Printing module may be missing. | 1. Attach either the Rear Access Door or the Automatic Two-Sided Printing Module to the back of the printer.  
2. Print your document again. |
### Problems?: Troubleshooting Tips

#### Why won’t it print?  Continued

<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem...</th>
</tr>
</thead>
</table>
| A blank page came out of the printer. | You may be out of ink. | 1 Lift the printer cover and check the Print Cartridge status icons to make sure you are not out of ink. See “Print Cartridge Status” on page 42.  
2 If you are out of ink, replace the print cartridge. See “Replacing Print Cartridges” on page 44. |
| | You may have forgotten to remove the vinyl tape from the print cartridge. | Make sure you have removed the protective piece of vinyl tape on each of the print cartridges. See “Replacing Print Cartridges” on page 44. |
| | You may be trying to print a fax. | 1 Save the fax in a graphic format, such as TIFF.  
2 Place it in a word processing document and print it from there. |

My printer is connected with a USB cable through another USB device or a hub and when I try to print I get a message saying “There was an error writing to <name of USB port>.”

Your printer may not be getting good data from the other device or hub.

Connect the printer directly to the USB port on the computer.
### Problems?: Troubleshooting Tips

#### Why won’t it print?  *Continued*

<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem…</th>
</tr>
</thead>
</table>
| I have a USB cable, and when I try to print I get a message saying “There was an error writing to LPT1.” | You may not have plugged your USB cable in before installing the software. | 1. Disconnect the USB cable from your printer.  
2. Uninstall your printer software.  
   a. Click Start ➔ Programs ➔ HP DeskJet 990C Series ➔ HP DeskJet 990C Series Uninstall.  
   b. Follow the instructions that appear on your computer screen.  
3. Reconnect the USB cable to your printer. The USB installation screen should appear again.  
4. Reinstall the printer software. See the *Quick Start Poster.* |

| The printer is really slow. | Your computer may have less than minimum system requirements. | 1. Check the amount of RAM and processor speed in your computer. See “System Requirements” on page 85.  
2. Free up some space on your hard drive. Having less than 100MB of free space on your computer’s hard drive can mean longer processing times. |
<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem…</th>
</tr>
</thead>
<tbody>
<tr>
<td>The printer is really slow. (continued)</td>
<td>You may be using outdated printer software.</td>
<td>Check the printer driver you are using. Check HP's web site for the most recent software updates (see page 75 for web site addresses).</td>
</tr>
<tr>
<td></td>
<td>You may be printing a complex document containing graphics or photographs.</td>
<td>Be patient. Large, complex documents containing graphics or photographs print slower than text documents.</td>
</tr>
<tr>
<td></td>
<td>• You may have chosen 2400 x 1200 dpi.</td>
<td>• In Photo Paper Printing, select PhotoREt instead of 2400 x 1200 dpi, then print your document again.</td>
</tr>
<tr>
<td></td>
<td>• You may be trying to print a photo.</td>
<td>• If you have selected PhotoREt, are using a parallel cable, and are having trouble printing, enable hardware ECP to speed photo printing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>a Open the HP DeskJet Toolbox (see page 13).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>b Click on the Configuration tab.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>c Check Attempt to Use Hardware ECP.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>d Apply your changes and try printing your photo again.</td>
</tr>
<tr>
<td>You may be using a USB cable and other USB devices are in use.</td>
<td>1 Attach the printer’s USB cable directly to the computer, rather than to a hub (if one is being used).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 Avoid using other devices attached to the hub while printing.</td>
<td>2 Avoid using other devices attached to the hub while printing.</td>
</tr>
<tr>
<td>The Paper Type option may be set to Automatic.</td>
<td>When the paper type is set to Automatic, the printer scans the first page of a print job to determine the appropriate paper type. This may take a few seconds. To avoid this, choose a specific paper type rather than using the default Automatic setting. See “Setup Tab” on page 8.</td>
<td>When the paper type is set to Automatic, the printer scans the first page of a print job to determine the appropriate paper type. This may take a few seconds. To avoid this, choose a specific paper type rather than using the default Automatic setting. See “Setup Tab” on page 8.</td>
</tr>
</tbody>
</table>

The printer will not turn on (all button lights are off).  The printer may have drawn too much power.  Disconnect the printer from the power cord for approximately 10 seconds. Reconnect the power cord and turn on the printer using the Power button.
<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Power Light is flashing.</td>
<td>Your printer may be receiving data.</td>
<td>Be patient. The light will stop flashing when the printer has finished receiving data.</td>
</tr>
</tbody>
</table>
| The Resume Light is flashing. | You may be out of paper. | 1. Insert paper.  
2. Press the Resume Button. |
| There may be a paper jam and you are using the Rear Access Door. | | 1. Pull the paper out of either the IN tray or the OUT tray.  
2. Press the Resume Button on the front of the printer.  
3. If you were printing labels, make sure a label did not become unglued from the label sheet while going through the printer.  
4. If the paper jam has cleared, print your document again.  
5. If the paper jam hasn’t cleared, open the Rear Access Door by turning the knob (counter-clockwise) and removing the door.  
6. Pull the jammed paper out of the printer, then replace the Rear Access Door.  
7. Print your document again. |
## What do the flashing lights mean?  *Continued*

<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Resume Light † is flashing. (continued)</td>
<td>There may be a paper jam and the Automatic Two-Sided Printing Module is attached.</td>
<td>1 Turn your printer off. 2 Press the button on top of the Automatic Two-Sided Printing Module and lower the access door. 3 Pull the jammed paper out of the Module, then close the access door. 4 Turn your printer back on. 5 Print your document again.</td>
</tr>
<tr>
<td></td>
<td>You may be printing a two-sided document manually and the first side has finished printing.</td>
<td>1 Follow the on-screen directions for how to insert the paper. 2 Press the Resume Button ❖.</td>
</tr>
<tr>
<td>The Print Cartridge Status Light ✦ is flashing.</td>
<td>The top cover may be open.</td>
<td>Close the top cover.</td>
</tr>
<tr>
<td></td>
<td>There may be a problem with one of the print cartridges.</td>
<td>See “Print Cartridge Status” on page 42.</td>
</tr>
</tbody>
</table>
### What is the problem?
- All of the upper lights are flashing.
- The infrared light is flashing.

### Possible cause
- The printer may need to be reset.
- The infrared lens of a laptop or notebook computer may be aligned with the infrared lens of the printer. This indicates that a connection has been established between the two devices.

### To solve the problem...

<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem...</th>
</tr>
</thead>
<tbody>
<tr>
<td>All of the upper lights are flashing.</td>
<td>The printer may need to be reset.</td>
<td>1. Press the Power Button [] to turn the printer off. Then press the Power Button [] again to turn the printer back on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. If that doesn’t solve the problem, press the Power button to turn the printer off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Unplug the printer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Plug the printer back in.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5. Press the Power Button [] to turn the printer on.</td>
</tr>
<tr>
<td>The infrared light is flashing.</td>
<td>The infrared lens of a laptop or notebook computer may be aligned with the infrared lens of the printer. This indicates that a connection has been established between the two devices.</td>
<td>Position the laptop or notebook:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• More than 3 feet (1 meter) from the printer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>OR</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• So its infrared lens is not aligned with the infrared lens on the printer (there should be more than a 30-degree total angle between the two lenses).</td>
</tr>
<tr>
<td>What is the problem?</td>
<td>Possible cause</td>
<td>To solve the problem...</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Parts of the document are missing or are in the wrong place.</td>
<td>You may have selected the wrong paper orientation.</td>
<td>Make sure you have selected the correct orientation (portrait or landscape) on the Features tab. See “Features Tab” on page 9.</td>
</tr>
<tr>
<td>You may have selected the wrong paper size.</td>
<td>Make sure you have selected the correct paper size in the Setup tab. See “Setup Tab” on page 8.</td>
<td></td>
</tr>
<tr>
<td>You may have selected the wrong margins.</td>
<td>Make sure the margins are within the printable area. See “Minimum Printing Margins” on page 85.</td>
<td></td>
</tr>
<tr>
<td>You may have accidentally left Poster Printing on.</td>
<td>Uncheck Poster Printing in the Features tab. See “Features Tab” on page 9.</td>
<td></td>
</tr>
<tr>
<td>You may have incorrectly scaled text or graphics.</td>
<td>Make sure text or graphics are scaled correctly using Scale to Fit on the Setup tab. See “Setup Tab” on page 8.</td>
<td></td>
</tr>
<tr>
<td>The document printed at an angle or is off-center.</td>
<td>Paper may not be loaded correctly. 1 Make sure the media is correctly oriented in the IN tray. 2 Make sure the paper guides fit snugly against the media.</td>
<td></td>
</tr>
</tbody>
</table>
### Is there a problem with your printout?  *Continued*

<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print quality is poor.</td>
<td>You may be running out of ink.</td>
<td>1 Check the print cartridges status. See “Print Cartridge Status” on page 42. 2 If you are running out of ink, replace the print cartridge. See “Replacing Print Cartridges” on page 44.</td>
</tr>
<tr>
<td>You may not be using the best media.</td>
<td>• Make sure that you are using media intended for HP DeskJet printers.  • Print quality is dramatically improved if you print on paper specifically designed for a certain output (photographs, for example), rather than using plain paper.</td>
<td></td>
</tr>
<tr>
<td>You may be printing on the wrong side of the media.</td>
<td>Make sure that the media is loaded print side down.</td>
<td></td>
</tr>
<tr>
<td>You may not have selected the correct paper type in the printer software.</td>
<td>Make sure that you have selected the correct paper type in the Setup tab. See “How to Print” on page 6.</td>
<td></td>
</tr>
<tr>
<td>You may be printing in Draft mode.</td>
<td>Click Normal or Best instead of Draft on the Setup tab. See “Setup Tab” on page 8.</td>
<td></td>
</tr>
<tr>
<td>You may be printing in grayscale.</td>
<td>Clear the Print in Grayscale check box on the Advanced tab. See “Advanced Tab” on page 10.</td>
<td></td>
</tr>
</tbody>
</table>
### Problems?: Troubleshooting Tips

<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print quality is poor. (continued)</td>
<td>You may need to clean the print cartridges.</td>
<td>See “Cleaning Print Cartridges” on page 46.</td>
</tr>
<tr>
<td></td>
<td>You may have forgotten to remove the vinyl tape from the print cartridge.</td>
<td>Make sure that you have removed the protective piece of vinyl tape on each of the print cartridges. See “Replacing Print Cartridges” on page 44.</td>
</tr>
<tr>
<td></td>
<td>Your print cartridges may be out of alignment.</td>
<td>If the color and black ink aren’t lining up on the printed page, go to the Printer Services tab of the HP Toolbox and click Calibrate the Printer. See “HP DeskJet Toolbox” on page 14.</td>
</tr>
</tbody>
</table>
| If you have smearing, you may be using too much ink. | | 1 Click Normal or Draft instead of Best on the Setup tab. See “Setup Tab” on page 8.  
2 Reduce the amount of ink by going to the Advanced tab and using the Ink Volume slider. See “Advanced Tab” on page 10.  
3 Increase the dry time by going to the Advanced tab and using the Dry Time slider. See “Advanced Tab” on page 10. |
### Is there a problem with your printout?  Continued

<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Banners aren’t printing correctly.</td>
<td>You may have forgotten to raise the OUT tray.</td>
<td>Make sure that the OUT tray is up.</td>
</tr>
<tr>
<td></td>
<td>You may have forgotten to select Banner in the printer software.</td>
<td>Make sure that you have selected Banner on the Setup tab. See “Setup Tab” on page 8.</td>
</tr>
</tbody>
</table>
| | You may have problems with the paper. | - If several sheets feed into the printer together, unfold and refold the paper.  
- If paper doesn’t feed into the printer correctly, be sure that the unattached edge of the banner paper stack is toward the printer (see page 41).  
- If the paper creases going through the printer, the paper might be unsuitable for banner printing. |
| You may have problems with your banner software. | For Windows 95, 98, 2000, and NT 4.0  
- If gaps in the printing appear at the ends of the sheets, the problem might be with your software program. See Release Notes by clicking Start ➔ Programs ➔ HP DeskJet 990C Series.  
For Windows 3.1x  
- If gaps in the printing appear at the ends of the sheets, the problem might be with your software program. See the Release Notes in the HP DeskJet 990C Series Program Group. |
### Problems?: Troubleshooting Tips

**Photos aren’t printing correctly.**

- **Possible cause:** You may not have inserted the photo paper correctly.
- **To solve the problem:**
  1. Insert the photo media *glossy side down.*
  2. The photo paper may not be fully engaged.
  3. You may not have selected the appropriate paper type or paper size.

<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photos aren’t printing correctly.</td>
<td>You may not have inserted the photo paper correctly.</td>
<td>Insert the photo media <em>glossy side down.</em></td>
</tr>
</tbody>
</table>
| | The photo paper may not be fully engaged. | 1. Insert the photo paper as far as it will go into the IN tray.  
   2. Make sure that the paper guides rest snugly against the photo paper. |
| | You may not have selected the appropriate paper type or paper size. | 1. Go to the **Setup** tab in the printer software. See “Setup Tab” on page 8.  
   2. Select an **HP Photo Paper** as the **Paper Type.**  
   3. Select the appropriate sized photo paper as the **Paper Size.** |
| | You may not have selected Best print quality. | 1. Go to the **Setup** tab in the printer software. See “Setup Tab” on page 8.  
   2. Select **Best** print quality. |
| The document didn’t print using the selected default print settings. | The printer’s default print settings may be different from the application’s print settings. In this situation, the application’s print settings will be used. | Select the appropriate print settings within the application. See “How to Print” on page 6. |

**Is there a problem with your printout?  Continued**
Problems?: Troubleshooting Tips

Is there a problem with your printout?  *Continued*

<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem…</th>
</tr>
</thead>
<tbody>
<tr>
<td>The print quality is different if the paper type is set to <strong>Automatic</strong> rather than the specific paper type.</td>
<td>When the paper type is set to <strong>Automatic</strong>, the print quality is automatically set to <strong>Normal</strong>. When the paper type is set to a specific paper type, the default print quality may be something different.</td>
<td>After selecting a paper type, choose the desired print quality. See “Setup Tab” on page 8.</td>
</tr>
<tr>
<td><strong>Automatic</strong> is set as the paper type, but the printer does not use the optimal paper mode.</td>
<td>The paper may be marked, scratched, or wrinkled.</td>
<td>The Automatic Paper-Type Sensor is less accurate if paper is damaged in any way. Make sure the paper is clear and free of scratches or wrinkles.</td>
</tr>
<tr>
<td></td>
<td>The paper may be letterhead or stationary with a preprinted pattern at the top edge.</td>
<td>The Automatic Paper-Type Sensor always sets this type of letterhead or stationary to <strong>Plain Paper</strong>. Manually select the appropriate paper type. See “Setup Tab” on page 8.</td>
</tr>
<tr>
<td></td>
<td>The paper may be dark in color or contain metallic fibers.</td>
<td>The Automatic Paper-Type Sensor may set this type of media to <strong>Plain Paper</strong>. Manually select the appropriate paper type. See “Setup Tab” on page 8.</td>
</tr>
<tr>
<td><strong>Automatic</strong> is set as the paper type, but when preparing to print, the printer spits out the paper.</td>
<td>The printer may have been placed in direct sunlight, overwhelming the Automatic Paper-Type Sensor.</td>
<td>Move the printer out of direct sunlight.</td>
</tr>
<tr>
<td>Paper falls to the floor after printing.</td>
<td>The OUT Tray Extension may not be pulled out.</td>
<td>Gently pull out the OUT Tray Extension. When your print job finishes, push the OUT Tray Extension back into its storage slot. See “OUT Tray” on page 5.</td>
</tr>
</tbody>
</table>
Is there a problem with your Automatic Two-Sided Printing Module?

<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem…</th>
</tr>
</thead>
</table>
| In the Two-Sided Printing section of the Features tab, the Automatic option is missing. | The Automatic Two-Sided Printing Module is not enabled in the Toolbox.       | 1  Go to the Configuration tab of the HP DeskJet Toolbox. See “HP DeskJet Toolbox” on page 13.  
2  Check Automatic Two-Sided Printing Module and click Apply.  
3  Go to the Features tab of the HP Printer Properties dialog box. See “Features Tab” on page 9.  
4  Select Two-Sided Printing.  
5  Choose a content size option and click OK.  
6  Make sure Automatic is selected. |
| In the Two-Sided Printing section of the Features tab, you can’t select the Automatic option. | You may have selected an unsupported paper type or size in the Setup tab. | In the Setup tab, make sure you have selected a paper type and size supported by the Automatic Two-Sided Printing Module. See “Automatic Two-Sided Printing Module Specifications” on page 83. |
| When Automatic Two-Sided Printing is selected in the Features tab, the paper size automatically changes. | The paper size selected in the Setup tab is not supported by the Automatic Two-Sided Printing Module. | In the Setup tab, make sure you have selected a paper size supported by the Automatic Two-Sided Printing Module. See “Automatic Two-Sided Printing Module Specifications” on page 83. |
## Problems? Troubleshooting Tips

### Is there a problem with your Automatic Two-Sided Printing Module? Continued

<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic Two-Sided Printing was selected, but printing is only on one side of the paper.</td>
<td>The application you are using to print supports only manual two-sided printing. It does not support Automatic Two-Sided Printing.</td>
<td>Print using the manual two-sided printing feature. See “Manual Two-Sided Printing” on page 31.</td>
</tr>
<tr>
<td>You have Automatic selected as the paper type and are using a media type that is not supported by the Automatic Two-Sided Printing Module.</td>
<td></td>
<td>Switch to a media type supported by the Automatic Two-Sided Printing Module or use manual two-sided printing. See “Automatic Two-Sided Printing Module Specifications” on page 83 or “Manual Two-Sided Printing” on page 31.</td>
</tr>
<tr>
<td>You are using a media size that is not supported by the Automatic Two-Sided Printing Module.</td>
<td></td>
<td>Switch to a media size supported by the Automatic Two-Sided Printing Module or use manual two-sided printing. See “Automatic Two-Sided Printing Module Specifications” on page 83 or “Manual Two-Sided Printing” on page 31.</td>
</tr>
<tr>
<td>The binding margin appears in the wrong place.</td>
<td>You may not have chosen the correct paper orientation.</td>
<td>Check the Features tab to ensure you have chosen the correct paper orientation for Two-Sided Printing—either Book or Tablet. See “Features Tab” on page 9.</td>
</tr>
<tr>
<td>What is the problem?</td>
<td>Possible cause</td>
<td>To solve the problem...</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>A connection cannot be established or the transmission seems to be taking longer</td>
<td>The device from which you are trying to print may not be IrDA-compliant.</td>
<td>Make sure the device is IrDA-compliant; look for an IrDA symbol or refer to the user’s guide for the device.</td>
</tr>
<tr>
<td>than usual.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Your laptop or notebook may not be configured for infrared.</td>
<td>Make sure your laptop or notebook is configured for infrared. See “Setting</td>
<td>Make sure your laptop or notebook is configured for infrared. See “Setting up a Laptop or Notebook for Infrared” on page 23.</td>
</tr>
<tr>
<td></td>
<td>up a Laptop or Notebook for Infrared” on page 23.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The infrared driver may not be installed on your laptop or notebook.</td>
<td>Make sure the infrared driver is installed. The infrared driver can be found on the Microsoft Windows 98/2000 software CD or downloaded from the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Microsoft web site at: <a href="http://www.microsoft.com">http://www.microsoft.com</a></td>
</tr>
<tr>
<td></td>
<td>Infrared may not be enabled on your laptop or notebook.</td>
<td>Make sure that infrared is enabled on your laptop or notebook. See “Enabling Infrared” on page 23.</td>
</tr>
<tr>
<td></td>
<td>An infrared port may not be selected on your laptop or notebook.</td>
<td>Select an infrared port. See “Preparing to Print” on page 24.</td>
</tr>
<tr>
<td></td>
<td>The device from which you are trying to print and the printer are not</td>
<td>• Position the device from which you are printing up to 3 feet (1 meter) from the printer and within a 30-degree total angle from the printer’s infrared</td>
</tr>
<tr>
<td></td>
<td>positioned properly.</td>
<td>lens.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Make sure the path between the two infrared devices is clear of obstacles.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Make sure the two infrared lenses are clean—free from dirt and grease.</td>
</tr>
</tbody>
</table>
## Problems?: Troubleshooting Tips

### Is there a problem with infrared (Ir) printing?  
*Continued*

<table>
<thead>
<tr>
<th>What is the problem?</th>
<th>Possible cause</th>
<th>To solve the problem…</th>
</tr>
</thead>
<tbody>
<tr>
<td>A connection cannot be established or the transmission seems to be taking longer than usual. <em>(continued)</em></td>
<td>Bright lights may be interfering with the signal.</td>
<td>- Make sure that no bright light of any type is shining directly into either infrared lens.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Position the device from which you are printing closer to the infrared lens on the printer.</td>
</tr>
<tr>
<td>The printer prints only part of a page or document.</td>
<td>The device from which you are printing may have been moved out of range of the printer’s infrared lens.</td>
<td>Try to realign the devices within approximately 3–30 seconds. If the print job does not resume, you must begin the printing process again.</td>
</tr>
<tr>
<td>Your Palm Pilot is only able to print a single calendar appointment.</td>
<td>Your Palm Pilot may not have a printing application installed.</td>
<td>A printing application must be installed in order to print more than one calendar appointment at a time.</td>
</tr>
</tbody>
</table>
HP DeskJet printers set the standard for quality and reliability, so you have made an excellent choice. Should you need help, however, HP Customer Care’s award-winning service and support is nearby to provide expert advice on using your HP printer or to answer specific questions about a problem you are having. Whether online or by phone, you’ll find the support you need—and you’ll find it fast.

**HP Customer Care Online**

Click your way to a quick solution! HP Customer Care Online is a great place to go for answers to questions about your HP products. You’ll get instant access to everything from helpful printing tips to the latest product and software updates—24 hours a day, seven days a week, all at no charge to you.

If you have a modem connected to your computer and subscribe to an online service or have direct access to the Internet, you can obtain a wide variety of information about your printer at the following web sites:

- **English:** [http://www.hp.com/go/support](http://www.hp.com/go/support)
- **French:** [http://www.hp.com/cposupport/fr](http://www.hp.com/cposupport/fr)
- **German:** [http://www.hp.com/cposupport/de](http://www.hp.com/cposupport/de)
- **Japanese:** [http://www.jpn.hp.com/CPO_TC/eschome.htm](http://www.jpn.hp.com/CPO_TC/eschome.htm)
- **Korean:** [http://www.hp.co.kr/go/support](http://www.hp.co.kr/go/support)
- **Simplified Chinese:** [http://www.hp.com.cn/go/support](http://www.hp.com.cn/go/support)
- **Spanish:** [http://www.hp.com/cposupport/es](http://www.hp.com/cposupport/es)
- **Swedish:** [http://www.hp.com/cposupport/sv](http://www.hp.com/cposupport/sv)
- **Traditional Chinese:** [http://support.hp.com.tw/psd](http://support.hp.com.tw/psd)

To choose your country or language, access HP Customer Care Online at [http://www.hp.com/apcpo-support/regional.html](http://www.hp.com/apcpo-support/regional.html). From there you can link to HP Customer Care User Forums and HP Customer Care Email. Go to the page for your product (for example, HP DeskJet 990C) and then choose Connect with HP.
HP Customer Care Online

continued

HP Customer Care User Forums

They’re friendly. They’re informative. Check out our online user forums. Simply review existing messages left by other HP users to find the answers you’re looking for. You can also post your questions, then check back later for ideas and suggestions from knowledgeable users and system operators.

HP Customer Care by Email

Connect with HP via email and receive a personal reply from an HP Customer Care service technician. Responses are normally provided within 24 hours of receipt (excluding holidays). A great option for those non-urgent questions. To send an email, go to http://contact.external.hp.com/support/menu/menu-post.html.

Printer Software Updates

Printer software (also referred to as a printer driver) allows your printer to talk with your computer. HP provides printer software and software updates for Windows operating systems. For MS-DOS printer software, contact the manufacturer of your software program. You have several options for getting printer software:

- Download the printer software by accessing the HP Customer Care Online web site. See “HP Customer Care Online” on page 75 for the addresses of the HP web sites.

- If you are using Windows 95, 98, or 3.1x and need diskettes rather than a CD, you can copy the printer software to diskettes by taking your printer software CD to your HP dealer or a friend that has a CD-ROM drive. Be sure to take along at least 6 blank diskettes. To create the diskettes, begin the printer software installation. When the opening screen appears, select Make diskettes of your printer software and follow the on-screen instructions.

- If you are in the U.S., setting up your printer for the first time, and do not have a CD-ROM drive or access to HP Customer Care Online, you can order the printer software on 3.5-inch diskettes by calling (661) 257-5565 (nominal shipping and handling charge may apply). Bonus software that may be provided on the CD will not be provided on diskettes.
- If you are in the U. S. and need a software update, you can download the printer software from HP’s web site at: http://www.hp.com/go/support. If you do not have access to the web site, call (661) 257-5565. Software updates are available for the cost of the CDs or diskettes plus shipping.
- If you are outside the U.S. and cannot download the driver from HP Customer Care Online (see page 75), call the HP Customer Care Center (see page 77) nearest you.

**HP Customer Care Repair**

If your HP printer is ever in need of repair, simply call the HP Customer Care Center. A trained service technician will diagnose the problem and coordinate the repair process for you. This service is free during your printer’s limited warranty period. Beyond the warranty period, repairs are charged on a time and materials basis.

---

**HP Customer Care by Phone**

Within one year from the time of your purchase, telephone support is provided to you free of charge. However, if you are calling long distance, long-distance charges may apply.

Before placing a call for help, please make sure that:

1. You have checked your Quick Start Poster and this User’s Guide for installation and troubleshooting tips.
2. You have checked HP Customer Care Online (see page 75) for product help.
3. If you cannot solve your problem using the above, then call an HP service technician while you’re in front of your computer and printer.
Before you call, be sure you have the following information:

- Your printer’s serial number (the label is on the bottom of the printer).

- Your printer’s model number (the label is on the front of the printer).

- The model of the computer.

- The version of the printer software and software program (if applicable). To find your printer software version, go to the HP DeskJet toolbox, click on the printer icon in the title bar, then select About from the drop-down menu.

Then we can help you with your questions immediately!

Problems?: HP Customer Care

See the list below, or refer to HP’s web site at: http://www.hp.com/cposupport/mail_support.html for your country’s HP Customer Care Center phone number:

- Argentina (541) 778-8380
- Australia +61 3 8877 8000
- Austria +43 (0) 711 420 10 80
- Belgium (Dutch) +32 (0)2 62688 06
- Belgium (French) +32 (0)2 62688 07
- Brazil 011 829-6612
- Canada (905) 206-4663
- Chile 800 36 0999
- China +86 (0) 10 6564 5959
- Czech Republic +42 02 6130 7310
- Denmark +45 (0) 39 29 4099
- English International +44 (0) 171 512 5202
- Finland +358 (0) 203 4 7 288
- France +33 (0) 143623434
- Germany +49 (0) 180 52 58 143
- Greece +30 (0) 1 619 64 11
- Hong Kong (800) 96 7729
- Hungary +36 (0) 1382 1111
- India +91 11 682 60 35
- Indonesia +62 (21) 350 3408
- Ireland +353 (0) 1662 5525
- Israel +972-(0)-9-9524848
- Italy +39 (0) 2 264 10350
- Japan 03-3335-8333
Problems?: HP Customer Care

- Korea +82 (2) 3270 0700
- Korea, outside Seoul 080 999 0700
- Malaysia +60 (3) 2952566
- Malaysia, Penang 1 300 88 00 28
- Mexico 01 800 472 6684
- Netherlands +31 (0) 20 606 8751
- New Zealand +64 (9) 356-6640
- Norway +47 22 116299
- Philippines +66 (2) 867 3551
- Poland +48 22 519 06 00
- Portugal +351 21 317 6333
- Republic of South Africa, inside RSA 086 000 1030
- Republic of South Africa, outside RSA +27-11 258 9301
- Russia, Moscow +7 095 797 3520
- Russia, St. Petersburg +7 812 346 7997
- Singapore +65 272 5300
- Spain +34 9 02321 123
- Sweden +46 (0) 8 6192170
- Switzerland +41 (0) 84 8801111
- Taiwan +886 2-2717-0055
- Thailand +66 (2) 661 4011
- Turkey +90 (0) 212 221 6969
- United Kingdom +44 (0) 207 512 5202
- U.S. (208) 344-4131
- Venezuela 800 47 888
- Vietnam +84 (0) 8 823 4530

After the Free Phone Support Period

You can still get help from HP for a fee. Prices are subject to change without notice. HP Customer Care Online help (see page 75) on the internet is still available for free!

- For quick questions in the United States only, call (900) 555-1500. The charges are $2.50 per minute and begin when you connect with a service technician.
- For calls from Canada, or for calls in the U.S. that you anticipate might be longer than ten minutes in length, call (800) 999-1148. The fee is US $25 per call, charged to your Visa or MasterCard.
- If, during your phone call, it is determined that your printer requires repair and you are within your printer’s Limited Warranty period (see the “Limited Warranty Statement” in your Reference Manual), you will not be charged for the phone support service. However, for countries where the above toll-free phone numbers are not available, the regular long-distance charges may apply.
Extended Warranty Options

If you would like to extend your printer coverage beyond the limited warranty period, you have the following options:

- Consult your reseller to get extended coverage.
- If your reseller does not offer service contracts, please call HP directly and ask about our HP Service Agreements. In the U.S., call (800) 446-0522; in Canada, call (800) 268-1221. For HP Service Agreements outside the U.S. and Canada, contact your local HP Sales Office.
More About Your Printer

Specifications

DeskJet 990Cxi model no. C6455A  
DeskJet 990Cse model no. C6455B

Black Text Print Speed *
Draft: Up to 17 pages per min.

Mixed Text with Color Graphics Print Speed *
Draft: Up to 13 pages per min.

Black TrueType™ Text Resolution  
(depends on paper type)
Draft: 300 x 300 dpi  
Normal: 600 x 600 dpi  
Best: 600 x 600 dpi

Color Resolution (depends on paper type)
Draft: 300 x 300 dpi  
Normal: PhotoREt  
Best: PhotoREt

Photo Paper Printing Resolution
PhotoREt  
2400 x 1200 dpi

* Approximate figures. Exact speed will vary depending on the paper type, system configuration, software programs, and document complexity.

Print Technology  
Drop-on-demand thermal inkjet printing

Software Compatibility  
MS Windows compatible (3.1x, 95, 98, 2000, and NT 4.0)  
MS-DOS software programs

Duty Cycle  
5,000 pages per month

Memory  
8MB built-in RAM

Buttons/Lights  
Cancel Button  
Print Cartridge Status Light  
Resume Button and Light  
Power Button and Light  
Infrared Light

I/O Interface  
Centronics Parallel, IEEE 1284-Compliant with 1284-B receptacle  
Universal Serial Bus  
IrDA version 1.1, 4 Mbps

Dimensions
With Automatic Two-Sided Printing Module:  
440 mm wide x 196 mm high x 435 mm deep  
17.32 in wide x 7.72 in high x 17.13 in deep

Without Automatic Two-Sided Printing Module:  
440 mm wide x 196 mm high x 375 mm deep  
17.32 in wide x 7.72 in high x 14.76 in deep

Weight  
With Automatic Two-Sided Printing Module:  
6.65 kg (14.65 lb) without print cartridges

Operating Environment
Maximum operating conditions:  
Temperature: 41 to 104°F, 5 to 40°C  
Humidity: 15 to 80% RH noncondensing

Recommended operating conditions for best print quality:  
Temperature: 59 to 95°F or 15 to 35°C  
Humidity: 20 to 80% RH noncondensing

Storage conditions:  
Temperature: -40 to 140°F, -40 to 60°C

Power Consumption  
2 watts maximum when off  
4 watts average non-printing  
40 watts average when printing
More About Your Printer: Specifications

Power Requirements
Input Voltage: 100 to 240 VAC (+10%)
Input Frequency: 50/60 Hz (+3 Hz)

Automatically accommodates the worldwide range of AC line voltages and frequencies.

Declared noise emissions in accordance with ISO 9296
Sound power level, LWAd (dB): 6.0 B in normal mode.
Sound pressure level, LpAm (bystander positions): 47 dB in normal mode.

Alignment
Skew: +/- .006 mm/mm (.006 in/in) on plain paper
       +/- .012 mm/mm (.012 in/in) on HP transparency films

Media Weight
Paper:
  U.S. Letter  60 to 90 g/m² (16 to 24 lb)
  Legal       75 to 90 g/m² (20 to 24 lb)
  Envelopes:  75 to 90 g/m² (20 to 24 lb)
Cards:       Up to 200 g/m² (110 lb index max)
Banner Paper: 60 to 90 g/m² (16 to 24 lb)

Media Handling
Sheets: up to 150
Banners: up to 20 sheets
Envelopes: up to 15
Cards: up to 45 cards
Greeting cards: up to 5 cards
Transparencies: up to 30
Labels: up to 20 sheets of labels (use only U.S. letter- or A4-sized sheets)
Photo paper:
  Draft: up to 35 sheets
  Normal: up to 50 sheets
  Best: up to 50 sheets

OUT tray capacity:
  Draft: up to 35 sheets
  Normal: up to 50 sheets
  Best: up to 50 sheets

Media Size
Paper:
  U.S. Letter 216 x 279 mm (8.5 x 11 in.)
  Legal 216 x 356 mm (8.5 x 14 in.)
  Executive 184 x 356 mm (8.5 x 14 in.)
  A4 210 x 297 mm
  A5 148 x 210 mm
  B5-JIS 182 x 257 mm

User Defined:
  Width 77 to 216 mm (3.0 to 8.5 in.)
  Length 127 to 356 mm (5.0 to 14 in.)

Banner:
  U.S. Letter 216 x 279 mm (8.5 x 11 in.)
  A4 210 x 297 mm

Envelopes:
  U.S. No. 10 105 x 241 mm (4.3 x 9.5 in.)
  Invitation A2 111 x 146 mm (4.37 x 5.75 in.)
  DL 220 x 110 mm
  C6 114 x 162 mm

Index/Greeting Cards:
  U.S. Letter 216 x 279 mm (8.5 x 11 in.)
  A6 105 x 148.5 mm

A6: 105 x 148.5 mm

Hagaki: 100 x 148 mm

Labels:
  U.S. Letter 216 x 279 mm (8.5 x 11 in.)
  A4 210 x 297 mm

Transparencies:
  U.S. Letter 216 x 279 mm (8.5 x 11 in.)
  A4 210 x 297 mm

Photo (with tear-off tab) 102 x 152 mm (4 x 6 in.)
Automatic Two-Sided Printing Module Specifications

Automatic Two-Sided Printing Module
model no. C6463A

Duty Cycle
5,000 sides of pages per month

Dimensions
324 mm (12.75 in.) long x 133 mm (5.25 in.)
wide x 111 mm (4.37 in.) high

Weight
0.79 kg (1.75 lbs.)

Declared noise emissions in accordance
with ISO 9296
Sound power level, LWA(dB): 6.1 dB in normal mode.
Sound pressure level, LpA dB (bystander positions): 48 dB in normal mode.

Media Weight
Letter and A4 paper: 60 to 90 g/m² (16 to 24 lb.)
Cards: up to 160 g/m² (90 lb. index maximum)

Minimum Printing Margins
Letter and Executive:
Left and right margins 0.25 in. (6.4 mm)
Top and bottom margins 0.46 in. (11.7 mm)

A4-size:
Left and right margins 3.4 mm (0.134 in.)
Top and bottom margins 11.7 mm (0.46 in.)

A5, B5, 5 x 8 in. Card, and User Defined Size:
Left and right margins 3.17 mm (0.125 in.)
Top and bottom margins 11.7 mm (0.46 in.)

Media Size
Paper:
Letter 8.5 x 11 in. (216 x 279 mm)
Executive 7.25 x 10.5 in. (184 x 279 mm)
A4 (210 x 297 mm)
A5 (148 x 210 mm)
B5 (182 x 257 mm)

Cards:
5 x 8 in. (127 x 203 mm)

User Defined Size:
Minimum 100 mm x 148 mm
3.94 in x 5.83 in.
Maximum 216 mm x 297 mm
8.5 in x 11.7 in.

More About Your Printer: Specifications

Media Type *
Plain paper
HP Bright White Inkjet Paper
Letter-size, 500 sheets C1824A
A4-size, 500 sheets C1825A
Letter-size, 250 sheets C5976B
A4-size, 250 sheets C5977B

HP Photo Quality Inkjet Paper, Matte Finish
Letter-size, 100 sheets C7007A

HP Photo Quality Inkjet Paper, Semi Gloss
Letter-size, 25 sheets C6983A
A4-size, 25 sheets (Europe) C6984A
A4-size, 25 sheets (Asia) C7006A

HP Premium Inkjet Heavyweight Paper
A4-size, 100 sheets C1853A
More About Your Printer: Specifications

Infrared Printing Specifications

Range
3 feet (1 meter)
30 degree cone

Supported Operating Systems
Some of the operating systems supported by infrared include:
- Windows 2000
- Windows 98
- Windows CE
- Palm

Supported Devices
Some of the devices supported by infrared include:
- Laptop or notebook computers with infrared capability (including the HP Omnibook)
- Some Personal Digital Assistants (including the Palm product line)
- Some Windows CE devices (including the HP Jornada)
- Digital cameras with infrared capability and the JetSend program (including the HP PhotoSmart)
- Cellular phones with infrared capability

Supported Protocols
- IrLPT
- JetSend
- OBEX

Media availability varies by country.

Note: The "HP Photo Paper, Two-Sided, Satin/Glossy" and "HP Glossy Greeting Cards, White Half-fold" paper types are not supported by the Automatic Two-Sided Printing module due to longer dry times.
Minimum Printing Margins

The printer cannot print outside a certain area of the page, so you must make sure the contents of your document fall within the printable area. When you use nonstandard paper sizes and select User Defined Paper Size setting from the Setup tab on the HP Printer Properties dialog box, the paper width must be between 77 and 215 mm (3 and 8.5 inches) and the paper length must be between 127 and 356 mm (5 and 14 inches).

<table>
<thead>
<tr>
<th>Paper Size</th>
<th>Left and Right Margins</th>
<th>Top Margin</th>
<th>Bottom Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4 Paper</td>
<td>3.4 mm (0.134 in.)</td>
<td>1.8 mm (0.07 in.)</td>
<td>11.7 mm (0.46 in.)</td>
</tr>
<tr>
<td>Letter, Legal, and Executive Paper</td>
<td>6.4 mm (0.25 in.)</td>
<td>1.8 mm (0.07 in.)</td>
<td>11.7 mm (0.46 in.)</td>
</tr>
<tr>
<td>A5, B5, and User Defined Paper Size</td>
<td>3.2 mm (0.125 in.)</td>
<td>1.8 mm (0.07 in.)</td>
<td>11.7 mm (0.46 in.)</td>
</tr>
<tr>
<td>Cards (3x5 in, 4x6, 5x8, and A6)</td>
<td>3.2 mm (0.125 in.)</td>
<td>1.8 mm (0.07 in.)</td>
<td>11.7 mm (0.46 in.)</td>
</tr>
<tr>
<td>Hagaki postcards</td>
<td>3.2 mm (0.125 in.)</td>
<td>1.8 mm (0.07 in.)</td>
<td>11.7 mm (0.46 in.)</td>
</tr>
<tr>
<td>Envelopes</td>
<td>3.2 mm (0.125 in.)</td>
<td>1.8 mm (0.07 in.)</td>
<td>11.7 mm (0.46 in.)</td>
</tr>
<tr>
<td>Banners: A4 (210 x 297 mm, 8.27 x 11.7 in.)</td>
<td>3.4 mm (0.134 in.)</td>
<td>0.0 mm (0.00 in.)</td>
<td>0.0 mm (0.00 in.)</td>
</tr>
<tr>
<td>Banners: Letter (8.5 x 11 in.)</td>
<td>6.4 mm (0.25 in.)</td>
<td>0.0 mm (0.00 in.)</td>
<td>0.0 mm (0.00 in.)</td>
</tr>
<tr>
<td>Photo with tear-off tab</td>
<td>3.2mm (0.125 in.)</td>
<td>3.2mm (0.125 in.)</td>
<td>3.2mm (0.125 in.)</td>
</tr>
</tbody>
</table>

Note: DOS margins can vary. See the manual for your specific DOS program for more information.

Be sure your computer meets the following system requirements:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Minimum Processor Speed</th>
<th>Required RAM</th>
<th>Required Free Hard-disk Space</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows 2000</td>
<td>Pentium 133 MHz</td>
<td>64 MB</td>
<td>40 MB</td>
</tr>
<tr>
<td>Microsoft Windows 95, 98 or NT 4.0</td>
<td>Pentium 66 MHz</td>
<td>32 MB</td>
<td>40 MB</td>
</tr>
<tr>
<td>Windows 3.1x</td>
<td>Pentium 66 MHz</td>
<td>8 MB</td>
<td>40 MB</td>
</tr>
<tr>
<td>MS-DOS Version 3.3 or greater</td>
<td>486 Processor</td>
<td>4 MB</td>
<td>5MB</td>
</tr>
</tbody>
</table>

* If you are printing photographs, you will need at least 100 MB of free hard disk space. If you are printing at 2400 x 1200 dpi, you will need at least 400 MB of free hard disk space.
## Language Codes

<table>
<thead>
<tr>
<th>Language</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bahasa Indonesia</td>
<td>bin</td>
</tr>
<tr>
<td>Bulgaria</td>
<td>bul</td>
</tr>
<tr>
<td>Chinese, Simplified</td>
<td>chs</td>
</tr>
<tr>
<td>Chinese, Traditional</td>
<td>cht</td>
</tr>
<tr>
<td>Czech</td>
<td>csy</td>
</tr>
<tr>
<td>Danish</td>
<td>dan</td>
</tr>
<tr>
<td>German</td>
<td>deu</td>
</tr>
<tr>
<td>English</td>
<td>enu</td>
</tr>
<tr>
<td>Spanish</td>
<td>esm</td>
</tr>
<tr>
<td>Finnish</td>
<td>fin</td>
</tr>
<tr>
<td>French</td>
<td>fra</td>
</tr>
<tr>
<td>Hungarian</td>
<td>hun</td>
</tr>
<tr>
<td>Italian</td>
<td>ita</td>
</tr>
<tr>
<td>Japanese</td>
<td>jpn</td>
</tr>
<tr>
<td>Kazakh</td>
<td>kzh</td>
</tr>
<tr>
<td>Korean</td>
<td>kor</td>
</tr>
<tr>
<td>Dutch</td>
<td>nld</td>
</tr>
<tr>
<td>Norwegian</td>
<td>non</td>
</tr>
<tr>
<td>Polish</td>
<td>plk</td>
</tr>
<tr>
<td>Portuguese</td>
<td>ptb</td>
</tr>
<tr>
<td>Russian</td>
<td>rus</td>
</tr>
<tr>
<td>Swedish</td>
<td>svc</td>
</tr>
<tr>
<td>Thai</td>
<td>tha</td>
</tr>
</tbody>
</table>
# Supplies and Accessories

For ordering information see page 91.

## Interface Cables

<table>
<thead>
<tr>
<th>Part Name</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP IEEE 1284-Compliant Parallel Interface Cable (with one 1284-A connector for the computer port and one 1284-B connector for the printer port)</td>
<td></td>
</tr>
<tr>
<td>2-meter length</td>
<td>C2950A</td>
</tr>
<tr>
<td>3-meter length</td>
<td>C2951A</td>
</tr>
<tr>
<td>HP USB-Compliant Interface Cable</td>
<td>C6518A</td>
</tr>
</tbody>
</table>

## Print Cartridges

- Black: HP 51645 Series or HP No. 45
- Tri-color: HP C6578 Series or HP No. 78

## Power Cords

- U.S., Canada, Brazil, Latin America, Saudi Arabia: 8120-8900
- Japan: 8121-0021
- Singapore, Malaysia, Hong Kong: 8121-0026
- South Africa: 8121-0020
- India: 8121-0025
- Argentina: 8121-0019
- Australia: 8121-0018
- China, Taiwan, Philippines: 8121-0024
- Korea: 8121-0017
- Europe, Jordan, Lebanon, North Africa, Israel, Russia, Baltic countries, Thailand, Indonesia, Caribbean, Latin America: 8121-0023
- U.K., Middle East: 8121-0022

## Other Replaceable Parts

<table>
<thead>
<tr>
<th>Part Name</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>DJ990C Series Printer Cleanout Access Door Assembly</td>
<td>C6426-60038</td>
</tr>
</tbody>
</table>

## Accessories

- HP Two-Sided Printing Accessory (not available in all countries): C6463A
## More About Your Printer: Supplies and Accessories

**Printer Quick Start Posters, Reference Manuals, and Network Guides**

Most HP printer documentation is available for viewing and printing at [http://www.hp.com/go/support](http://www.hp.com/go/support)

<table>
<thead>
<tr>
<th>Language</th>
<th>Quick Start Poster</th>
<th>Reference Manual</th>
<th>Network Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arabic</td>
<td>C6455-90074</td>
<td>C6455-90060</td>
<td>C6455-90050</td>
</tr>
<tr>
<td>Bahasa Indonesia</td>
<td>C6455-90076</td>
<td>C6455-90066</td>
<td>C6455-90056</td>
</tr>
<tr>
<td>Bulgarian</td>
<td>C6455-90075</td>
<td>C6455-90064</td>
<td>C6455-90054</td>
</tr>
<tr>
<td>Croatian</td>
<td>C6455-90072</td>
<td>C6455-90063</td>
<td>C6455-90053</td>
</tr>
<tr>
<td>Czech</td>
<td>C6455-90072</td>
<td>C6455-90063</td>
<td>C6455-90053</td>
</tr>
<tr>
<td>Danish</td>
<td>C6455-90070</td>
<td>C6455-90062</td>
<td>C6455-90052</td>
</tr>
<tr>
<td>Dutch</td>
<td>C6455-90074</td>
<td>C6455-90060</td>
<td>C6455-90050</td>
</tr>
<tr>
<td>English</td>
<td>Request numbers with order</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Estonian</td>
<td>C6455-90075</td>
<td>C6455-90064</td>
<td>C6455-90054</td>
</tr>
<tr>
<td>Finnish</td>
<td>C6455-90070</td>
<td>C6455-90062</td>
<td>C6455-90052</td>
</tr>
<tr>
<td>French</td>
<td>Request numbers with order</td>
<td></td>
<td></td>
</tr>
<tr>
<td>German</td>
<td>C6455-90074</td>
<td>C6455-90061</td>
<td>C6455-90051</td>
</tr>
<tr>
<td>Greek</td>
<td>C6455-90075</td>
<td>C6455-90064</td>
<td>C6455-90054</td>
</tr>
<tr>
<td>Hebrew</td>
<td>C6455-90075</td>
<td>C6455-90064</td>
<td>C6455-90054</td>
</tr>
<tr>
<td>Hungarian</td>
<td>C6455-90072</td>
<td>C6455-90063</td>
<td>C6455-90053</td>
</tr>
<tr>
<td>Italian</td>
<td>C6455-90074</td>
<td>C6455-90060</td>
<td>C6455-90050</td>
</tr>
<tr>
<td>Japanese</td>
<td>C6455-90076</td>
<td>C6455-90066</td>
<td>C6455-90056</td>
</tr>
<tr>
<td>Kazakh</td>
<td>C6455-90075</td>
<td>C6455-90064</td>
<td>C6455-90054</td>
</tr>
<tr>
<td>Korean</td>
<td>C6455-90077</td>
<td>C6455-90065</td>
<td>C6455-90055</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Language</th>
<th>Quick Start Poster</th>
<th>Reference Manual</th>
<th>Network Guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lithuanian</td>
<td>C6455-90075</td>
<td>C6455-90064</td>
<td>C6455-90054</td>
</tr>
<tr>
<td>Norwegian</td>
<td>C6455-90070</td>
<td>C6455-90062</td>
<td>C6455-90052</td>
</tr>
<tr>
<td>Polish</td>
<td>C6455-90072</td>
<td>C6455-90063</td>
<td>C6455-90053</td>
</tr>
<tr>
<td>Portuguese</td>
<td>Request numbers with order</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Romanian</td>
<td>C6455-90072</td>
<td>C6455-90063</td>
<td>C6455-90053</td>
</tr>
<tr>
<td>Russian/Cyrillic</td>
<td>C6455-90075</td>
<td>C6455-90064</td>
<td>C6455-90054</td>
</tr>
<tr>
<td>Simplified Chinese</td>
<td>C6455-90077</td>
<td>C6455-90065</td>
<td>C6455-90055</td>
</tr>
<tr>
<td>Slovakian</td>
<td>C6455-90072</td>
<td>C6455-90063</td>
<td>C6455-90053</td>
</tr>
<tr>
<td>Slovenian</td>
<td>C6455-90072</td>
<td>C6455-90063</td>
<td>C6455-90053</td>
</tr>
<tr>
<td>Spanish</td>
<td>Request numbers with order</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Swedish</td>
<td>C6455-90070</td>
<td>C6455-90062</td>
<td>C6455-90052</td>
</tr>
<tr>
<td>Thai</td>
<td>C6455-90077</td>
<td>C6455-90065</td>
<td>C6455-90055</td>
</tr>
<tr>
<td>Traditional Chinese</td>
<td>C6455-90077</td>
<td>C6455-90065</td>
<td>C6455-90055</td>
</tr>
<tr>
<td>Turkish</td>
<td>C6455-90072</td>
<td>C6455-90063</td>
<td>C6455-90053</td>
</tr>
</tbody>
</table>
## Paper and Other Media

Availability of special media varies by country.

<table>
<thead>
<tr>
<th>Paper Type/Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HP Bright White InkJet Paper</strong></td>
<td></td>
</tr>
<tr>
<td>A4 (210 x 297 mm), 250 sheets</td>
<td>C5977B</td>
</tr>
<tr>
<td>A4 (210 x 297 mm), 500 sheets</td>
<td>C1825A</td>
</tr>
<tr>
<td>U.S. letter, 250 sheets</td>
<td>C5976B</td>
</tr>
<tr>
<td>U.S. letter, 500 sheets</td>
<td>C1824A</td>
</tr>
<tr>
<td><strong>HP Premium InkJet Paper</strong></td>
<td></td>
</tr>
<tr>
<td>A4 (210 x 297 mm), 200 sheets</td>
<td>C51634Z</td>
</tr>
<tr>
<td>U.S. letter, 200 sheets</td>
<td>C51634Y</td>
</tr>
<tr>
<td><strong>HP Premium InkJet Heavyweight Paper</strong></td>
<td></td>
</tr>
<tr>
<td>A4 (210 x 297 mm), 100 sheets</td>
<td>C1853A</td>
</tr>
<tr>
<td><strong>HP Professional Brochure &amp; Flyer Paper, Two-Sided Matte Finish</strong></td>
<td></td>
</tr>
<tr>
<td>U.S. letter, 50 sheets</td>
<td>C6955A</td>
</tr>
<tr>
<td><strong>HP Professional Brochure &amp; Flyer Paper, Two-Sided Gloss</strong></td>
<td></td>
</tr>
<tr>
<td>Asian A4 (210 x 297 mm), 50 sheets</td>
<td>C6819A</td>
</tr>
<tr>
<td>European A4 (210 x 297 mm), 50 sheets</td>
<td>C6818A</td>
</tr>
<tr>
<td>U.S. letter, 50 sheets</td>
<td>C6817A</td>
</tr>
<tr>
<td><strong>HP Photo Paper, Two-Sided, Satin/Glossy</strong></td>
<td></td>
</tr>
<tr>
<td>Asian A4 (210 x 297 mm), 20 sheets</td>
<td>C6765A</td>
</tr>
<tr>
<td>European A4 (210 x 297 mm), 20 sheets</td>
<td>C1847A</td>
</tr>
<tr>
<td>U.S. letter, 20 sheets</td>
<td>C1846A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper Type/Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HP Premium Photo Paper, Glossy</strong></td>
<td></td>
</tr>
<tr>
<td>Asian A4 (210 x 297 mm), 15 sheets</td>
<td>C6043A</td>
</tr>
<tr>
<td>European A4 (210 x 297 mm), 15 sheets</td>
<td>C6040A</td>
</tr>
<tr>
<td>U.S. letter, 15 sheets</td>
<td>C6039A</td>
</tr>
<tr>
<td><strong>HP Premium Plus Photo Paper, Glossy</strong></td>
<td></td>
</tr>
<tr>
<td>A4 (210 x 297 mm), 20 sheets</td>
<td>C6832A</td>
</tr>
<tr>
<td>U.S. letter, 20 sheets</td>
<td>C6831A</td>
</tr>
<tr>
<td><strong>HP Premium Plus Photo Paper, Matte</strong></td>
<td></td>
</tr>
<tr>
<td>A4 (210 x 297 mm), 20 sheets</td>
<td>C6951A</td>
</tr>
<tr>
<td>U.S. letter, 20 sheets</td>
<td>C6950A</td>
</tr>
<tr>
<td><strong>HP Premium Plus Photo Paper, Glossy</strong></td>
<td></td>
</tr>
<tr>
<td>European (102 x 152 mm finished size), 20 sheets</td>
<td>C6945A</td>
</tr>
<tr>
<td>U.S. (4 x 6 in. finished size), 20 sheets</td>
<td>C6944A</td>
</tr>
<tr>
<td><strong>HP Premium Inkjet Transparency Film</strong></td>
<td></td>
</tr>
<tr>
<td>A4 (210 x 297 mm), 20 sheets</td>
<td>C3832A</td>
</tr>
<tr>
<td>A4 (210 x 297 mm), 50 sheets</td>
<td>C3835A</td>
</tr>
<tr>
<td>U.S. letter, 20 sheets</td>
<td>C3828A</td>
</tr>
<tr>
<td>U.S. letter, 50 sheets</td>
<td>C3834A</td>
</tr>
</tbody>
</table>
# More About Your Printer: Supplies and Accessories

<table>
<thead>
<tr>
<th>Paper Type/Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HP Banner Paper</strong></td>
<td></td>
</tr>
<tr>
<td>A4 (210 x 297 mm), 100 sheets</td>
<td>C1821A</td>
</tr>
<tr>
<td>U.S. letter, 100 sheets</td>
<td>C1820A</td>
</tr>
<tr>
<td><strong>HP Matte Greeting Cards, White/Quarter-fold</strong></td>
<td></td>
</tr>
<tr>
<td>A4 (210 x 297 mm), 20 sheets, 20 envelopes</td>
<td>C6042A</td>
</tr>
<tr>
<td>U.S. letter, 20 sheets, 20 envelopes</td>
<td>C1812A</td>
</tr>
<tr>
<td><strong>HP Felt-textured Greeting Cards, Ivory/Half-fold</strong></td>
<td>C6828A</td>
</tr>
<tr>
<td>U.S. letter, 20 sheets, 20 envelopes</td>
<td></td>
</tr>
<tr>
<td><strong>HP Glossy Greeting Cards, White/Half-fold</strong></td>
<td></td>
</tr>
<tr>
<td>A4 (210 x 297 mm), 20 sheets, 20 envelopes</td>
<td>C6045A</td>
</tr>
<tr>
<td>U.S. letter, 10 sheets, 10 envelopes</td>
<td>C6044A</td>
</tr>
<tr>
<td><strong>HP Iron-on T-Shirt Transfers</strong></td>
<td></td>
</tr>
<tr>
<td>Asian A4 (210 x 297 mm), 10 sheets</td>
<td>C6065A</td>
</tr>
<tr>
<td>European A4 (210 x 297 mm), 10 sheets</td>
<td>C6050A</td>
</tr>
<tr>
<td>U.S. letter, 10 sheets</td>
<td>C6049A</td>
</tr>
<tr>
<td><strong>HP Restickables, Large Round Inkjet Stickers</strong></td>
<td></td>
</tr>
<tr>
<td>U.S. letter, 10 sheets (90 stickers)</td>
<td>C6822A</td>
</tr>
<tr>
<td><strong>HP Restickables, Large Square Inkjet Stickers</strong></td>
<td></td>
</tr>
<tr>
<td>U.S. letter, 10 sheets (90 stickers)</td>
<td>C6823A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper Type/Description</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HP Photo Quality Inkjet Paper, Matte Finish</strong></td>
<td></td>
</tr>
<tr>
<td>U.S. letter, 100 sheets</td>
<td>C7007A</td>
</tr>
<tr>
<td><strong>HP Photo Quality Inkjet Paper, Semi Gloss</strong></td>
<td></td>
</tr>
<tr>
<td>Asian A4 (210 x 297 mm), 25 sheets</td>
<td>C7006A</td>
</tr>
<tr>
<td>European A4 (210 x 297 mm), 25 sheets</td>
<td>C6984A</td>
</tr>
<tr>
<td>U.S. letter, 25 sheets</td>
<td>C6983A</td>
</tr>
</tbody>
</table>

*These paper types are supported by the Automatic Two-Sided Printing Module.

**Note:** To find out which recycled papers are recommended for your printer, contact your local HP Sales Office and ask for the HP InkJet Printer Family Paper Specifications Guide, HP part number 5961-0920.
Ordering Information

To order printer supplies or accessories, call your nearest HP dealer or call HP DIRECT at the following numbers for fast shipping service.

In the U.S., you can buy supplies and accessories directly from HP at www.hpshopping.com, or call the HP Shopping Village at 1-888-999-4747.

In Europe, you can buy supplies and accessories directly from HP at www.hp-gosupplies.com/order/index.shtml.

- **Argentina**: (54 1) 787-7100
  Fax: (54 1) 787-7213
  Hewlett-Packard Argentina, Montañoses 2150 1428
  Buenos Aires, Argentina

- **Australia/New Zealand**: (03) 895-2895
  China Resources Bldg.
  26 Harbour Road
  Wanchai, Hong Kong

- **Austria-South-East Area**: 43 (0) 7114 201080
  Fax: (43-0222) 25 000, ext. 610
  Hewlett-Packard Ges.m.b.H.
  Ersatzteilverkauf Lieblg. 1
  A-1222 Wien

- **Belgium**: 02/778 3092 (or 3090, 3091)
  Fax: 02/778 3076
  Hewlett-Packard Belgium SA/NV
  100 bd. de la Woluwe/Woluwedal
  1200 BRUXELLES

- **Brazil**: Centro de Informacoes HP
  Grande São Paulo: (11) 3747-7799
  Demais Localidades: 0800-157751
  Fax: (011) 829-7116
  Centro de Informacoes HP
  Hewlett Packard Brasil S.A.
  Caixa Postal 134, Rua Clodomiro Amazonas, 258
  CEP 04534-011, São Paulo - SP

- **Canada**: (800) 387-3154, (905) 206-4725
  Fax: (905) 206-3485/-3739
  Hewlett-Packard (Canada) Ltd.
  5150 Spectrum Way
  Mississauga, Ontario L4W 5G1
  **Toronto**: (416) 671-8383

- **Chile**: (56 2) 203-3233
  Fax: (56 2) 203-3234
  Hewlett-Packard de Chile SA
  Av. Andres Bello 2777, Oficina 1302
  Los Condes, Santiago, Chile

- **Denmark**: 45 99 14 29
  Fax: 42 81 58 10
  Hewlett-Packard A/S
  Kongevejen 25, 3460 BIRKEROD

- **Finland**: (90) 8872 2397
  Fax: (90) 8872 2620
  Hewlett-Packard Oy
  Varasosmyynti, Piispankalliontie 17
  02200 ESPOO

- **France**: (1) 40 85 71 12
  Fax: (1) 47 98 26 08
  EuroParts
  77 101 avenue du Vieux Chemin de Saint-Denis
  92625 GENNEVILLES

- **Germany**: 07031-145444
  Fax: 07031-141395
  Hewlett-Packard GmbH, HP Express Support
  Ersatzteil-Verkauf, Herrenberger Str. 130
  71034 BOEBLINGEN

- **International Sales Branch**: (41) 22 780 4111
  Fax: (41) 22 780-4770
  Hewlett-Packard S. A., ISB
  39, rue de Veyrot 1217 MEYRIN 1
  GENEVE - SUISSE

- **Italy**: 02/9212.2336/2475
  Fax: 02/92101757
  Hewlett-Packard Italiana S. P. A.
  Ufficio Parti di ricambio
  Via G. Di Vittorio, 9
  20063 Cernusco s/N (MI)

- **Japan**: (03) 3335-8333
  Hewlett-Packard Japan Ltd.
  29-21 Takaido-Higashi 3-chome, sugininami-ku
  Tokyo 168-8585
More About Your Printer: Ordering Information

- **Korea**: (02) 3270-0720
  Fax: (02) 3270-0894
  Hewlett-Packard Korea
  16-58 Hangangro3ga Yongsangu
  Seoul, Korea

- **Latin America Headquarters**: (305) 267-4220
  Fax: (305) 267-4247
  5200 Blue Lagoon Drive, Suite 930
  Miami, FL 33126

- **Mexico**: (52 5) 258-4600
  Fax: (54 1) 258-4362
  Hewlett-Packard de Mexico, S.A. de C.V
  Prolongación Reforma #470
  Colonia Lomas de Santa Fe, C.P. 01210 Mexico

- **Netherlands**: 0 33 450 1808
  Fax: 0 33 456 0891
  Hewlett-Packard Nederland B.V.
  Parts Direct Service
  Basicweg 10
  3821 BR AMERSFOORT

- **Norway**: 22735926
  Fax: 22735611
  Hewlett-Packard Norge A/S, Express Support
  Drammensveien 169-171
  0212 Oslo

- **Spain**: 1 6 31 14 81
  Fax: 1 6 31 12 74
  Hewlett-Packard Espanola S.A.
  Departamento de Venta de Piezas
  Ctra N-VI, Km. 16,500
  28230 LAS ROZAS, Madrid

- **Sweden**: 8-4442239
  Fax: 8-4442116
  Hewlett-Packard Sverige AB
  Skalholtsgatan 9, Box 19
  164 93 KISTA

- **Switzerland**: 056/279 286
  Fax: 056/279 280
  Elbatex Datentechnik AG
  Schwimmbadstrasse 45, 5430 WETTINGEN

- **United Kingdom**: +44 1765 690061
  Fax: +44 1765 690731
  Express Terminals, 47 Allhallowgate
  Ripon, North Yorkshire

- United States: (800) 227-8164

- **Venezuela**: (58 2) 239-4244/4133
  Fax: (58 2) 207-8014
  Hewlett-Packard de Venezuela C.A.
  Tercera Transversal de Los Ruices Norte
  Edificio Segre, Caracas 1071, Venezuela
  Apartado Postal 50933, Caracas 1050

- Elsewhere in the world
  Hewlett-Packard Company
  Intercontinental Headquarters,
  3495 Deer Creek Road,
  Palo Alto, CA 94304, U.S.A.
Legal Information

Regulatory Notices

Hewlett-Packard Company

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to this equipment not expressly approved by Hewlett-Packard Company may cause harmful interference, and void your authority to operate this equipment. Use of a shielded data cable is required to comply with the Class B limits of Part 15 of the FCC Rules.

For further information, contact:
Hewlett-Packard Company
Manager of Corporate Product Regulations
3000 Hanover Street
Palo Alto, Ca 94304
(415) 857-1501

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, can cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and the receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

LED Indicator Statement

The display LEDs meet the requirements of EN 60825-1.

この装置は、情報処理装置等電波障害自主規制協議会（V C C I）の基準に基づくクラスB情報技術装置です。この装置は、家庭環境で使用することを目的としていますが、この装置がラジオやテレビジョン受信機に近接して使用されると受信障害を引き起こすことがあります。
取り扱い説明書に従って正しい取り扱いをして下さい。

사용자 안내문 (한국어)
이 기기는 비업무용으로 전자파해량등록을 받은 기기로서, 주거지역에서는 물론 모든 지역에서 사용할 수 있습니다.
Limited Warranty Statement

A. Extent of Limited Warranty

1. Hewlett-Packard (HP) warrants to the end-user customer that the HP products specified above will be free from defects in materials and workmanship for the duration specified above, which duration begins on the date of purchase by the customer. Customer is responsible for maintaining proof of date of purchase.

2. For software products, HP’s limited warranty applies only to a failure to execute programming instructions. HP does not warrant that the operation of any product will be uninterrupted or error-free.

3. HP’s limited warranty covers only those defects which arise as a result of normal use of the product, and do not apply to any:
   a. Improper or inadequate maintenance or modification;
   b. Software, interfacing, media, parts, or supplies not provided or supported by HP;
   c. Operation outside the product's specifications.

4. For HP printer products, the use of a non-HP ink cartridge or a refilled ink cartridge does not affect either the warranty to the customer or any HP support contract with the customer. However, if printer failure or damage is attributable to the use of a non-HP or refilled ink cartridge, HP will charge its standard time and materials charges to service the printer for the particular failure or damage.

5. If HP receives, during the applicable warranty period, notice of a defect in any software, media, or ink cartridge product which is covered by HP’s warranty, HP shall replace the defective product. If HP receives, during the applicable warranty period, notice of a defect in any hardware product which is covered by HP’s warranty, HP shall either repair or replace the defective product, at HP’s option.

6. If HP is unable to repair or replace, as applicable, a defective product which is covered by HP’s warranty, HP shall, within a reasonable time after being notified of the defect, refund the purchase price for the product.

7. HP shall have no obligation to repair, replace, or refund until the customer returns the defective product to HP.

8. Any replacement product may be either new or like-new, provided that it has functionality at least equal to that of the product being replaced.

9. HP’s limited warranty is valid in any country where the covered HP product is distributed by HP except for the Middle East, Africa, Argentina, Brazil, Mexico, Venezuela, and France’s “Departements D’Outre-Mer”; for those excepted areas, the warranty is valid only in the country of purchase. Contracts for additional warranty services, such as on-site service, may be available from any authorized HP service facility where the product is distributed by HP or by an authorized importer.

B. Limitations of Warranty

1. TO THE EXTENT ALLOWED BY LOCAL LAW, NEITHER HP NOR ITS THIRD PARTY SUPPLIERS MAKE ANY OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED, WITH RESPECT TO THE HP PRODUCTS, AND SPECIFICALLY DISCLAIM THE IMPLIED WARRANTIES OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.

2. TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH IN THIS WARRANTY STATEMENT, IN NO EVENT SHALL HP OR ITS THIRD PARTY SUPPLIERS BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON CONTRACT, TORT, OR ANY OTHER LEGAL THEORY AND WHETHER ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

C. Limitations of Liability

1. To the extent allowed by local law, the remedies provided in this Warranty Statement are the customer’s sole and exclusive remedies.

2. TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH IN THIS WARRANTY STATEMENT, IN NO EVENT SHALL HP OR ITS THIRD PARTY SUPPLIERS BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON CONTRACT, TORT, OR ANY OTHER LEGAL THEORY AND WHETHER ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

D. Local Law

1. This Warranty Statement gives the customer specific legal rights. The customer may also have other rights which vary from state to state in the United States, from province to province in Canada, and from country to country elsewhere in the world.

2. To the extent that this Warranty Statement is inconsistent with local law, this Warranty Statement shall be deemed modified to be consistent with such local law. Under such local law, certain disclaimers and limitations of this Warranty Statement may not apply to the customer. For example, some states in the United States, as well as some governments outside the United States (including provinces in Canada), may:
   a. Preclude the disclaimers and limitations in this Warranty Statement from limiting the statutory rights of a consumer (e.g., the United Kingdom);
   b. Otherwise restrict the ability of a manufacturer to enforce such disclaimers or limitations; or
   c. Grant the customer additional warranty rights, specify the duration of implied warranties which the manufacturer cannot disclaim, or not allow limitations on the duration of implied warranties.

3. FOR CONSUMER TRANSACTIONS IN AUSTRALIA AND NEW ZEALAND, THE TERMS IN THIS WARRANTY STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT, OR MODIFY, AND ARE IN ADDITION TO, THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF HP PRODUCTS TO SUCH CUSTOMERS.

HP Year 2000 Warranty

Subject to all of the terms and limitations of the HP Limited Warranty Statement stated above, HP warrants that this HP Product will be able to accurately process date data (including, but not limited to, calculating, comparing, and sequencing) from, into, and between the twentieth and twenty-first centuries, and the years 1999 and 2000, including leap year calculations, when used in accordance with the Product documentation provided by HP (including any instructions for installing patches or upgrades), provided that all other products (e.g., hardware, software, firmware) used in combination with such HP Product(s) properly exchange date data with it. The duration of the Year 2000 warranty extends through January 31, 2001.
More About Your Printer: Environmental Statement

Hewlett-Packard continuously improves the design processes of HP DeskJet printers to minimize the negative impact on the office environment and on the communities where printers are manufactured, shipped, and used. Hewlett-Packard has also developed processes to minimize the negative impact of the disposal of the printer at the end of printing life.

Reduction and Elimination

Paper Use: The printer’s automatic/manual two-sided printing capability reduces paper usage and the resulting demands on natural resources. This printer is suited for the use of recycled papers according to DIN 19 309.

Ozone: Ozone-depleting chemicals such as CFCs have been eliminated from Hewlett-Packard manufacturing processes.

Recycling

Design for recycling has been incorporated into this printer. The number of materials has been kept to a minimum while ensuring proper functionality and reliability. Dissimilar materials have been designed to separate easily. Fasteners and other connections are easy to locate, access, and remove using common tools. High priority parts have been designed to access quickly for efficient disassembly and repair. Plastic parts have been primarily designed in no more than two colors to enhance recycling options. A few small parts are colored specifically to highlight customer access points.

Printer Packaging: The packaging materials for this printer have been selected to provide maximum protection for the least cost possible, while attempting to minimize environmental impact and facilitate recycling. The rugged design of the HP DeskJet printer assists in minimizing both packaging materials and damage rates.

Plastic parts: All major plastics and plastic parts are marked according to international standards. All plastic parts used in the printer housing and chassis are technically recyclable and all use a single polymer.

Energy Consumption

This printer was designed with energy conservation in mind. This printer averages 4 watts in stand-by mode. Not only does this save natural resources, but it also saves money without affecting the high performance of this printer. This product qualifies for the ENERGY STAR Program (U.S. and Japan). ENERGY STAR is a voluntary program established to encourage the development of energy-efficient office products. ENERGY STAR is a US registered service mark of the US EPA. As an ENERGY STAR partner, Hewlett-Packard Company has determined that this product meets ENERGY STAR Guidelines for energy efficiency.

Energy consumption in off-mode: When the printer is off, a minimal amount of energy is still being consumed. Energy consumption can be prevented by turning the printer power off, then disconnecting the end of the printer power cord from the electrical source.

Product Longevity: To ensure the longevity of your DeskJet Printer, HP provides the following:

- Extended Warranty - HP SupportPack provides coverage for the HP hardware and product and all HP supplied internal components. HP SupportPack must be purchased by the customer within 30 days of purchase. Contact the nearest HP dealer about this service.
- Spare Parts and Consumables are available for five years after production has stopped.
- Product Take-back - To return this product and ink cartridges to HP at the end of its useful life, call your local HP Sales or Service Office for instructions.
Index

Numerics
2400 x 1200 dpi 8, 37, 56, 61, 81

A
accessories 87
adjusting color 10
Advanced tab 10
Automatic Image Enhancement 10
Automatic Paper-Type Sensor
  turning off 20
  using 19
automatic two-sided printing 21
  Book 21
  Tablet 21
Automatic Two-Sided Printing Module
  installing 20
  printing with 21

B
banners
  ordering 90
  printing 5, 8, 12, 41
problems 68
software compatibility 68
specifications 82

book binding 31
borders 9
Brightness 10
business cards
  printing 35
buttons
  Apply 10
  Cancel 4, 10, 81
  Factory Settings 10
  Help 10
  OK 10
  Power 4, 44, 46, 47, 64, 81
  Resume 4, 32, 56, 81

color
  brightness 10
  grayscale 10
  printing 10
  saturation 10
  settings 10
  tone setting 10
calibrating printer 14, 67
Cancel button 4, 81
cards
  specifications 82, 85, 90
cleaning
  print cartridge cradle 48
  print cartridges 47
  printer 29
cables
  ordering 87
  USB 53, 54, 55, 59, 60, 61
calibrating printer 14, 67
Customer Care, see HP Customer Care
customer support, see HP Customer Care
D
DeskJet Toolbox
  accessing 13
  Configuration tab 14
  Estimated Ink Level tab 14
  How Do I? tab 15
  Printer Services tab 14
  Windows 3.1x 15
dialog boxes
  HP Printer Properties 7
door, rear access 57, 62
DOS, printing 3
dpi
  2400 x 1200 printing 8, 37, 56, 61, 81
  PhotoREt 8, 37, 56, 61, 81
drivers, see printer software
dry time
  decreasing 10
  increasing 10
duty cycle 81
E
energy usage 81
envelope slot 5
envelopes
  printing single 33
  printing stack 34
  specifications 82, 85
Estimated Ink Level tab 14
F
Factory Settings button 10
fax printing, problems 59
Features tab
  Windows 3.1x 12
  Windows 95, 98, 2000, NT 4.0 9
G
getting help, see help
grayscale 10, 66
greeting cards
  printing 38
  specifications 82
H
help
  customer
    HP Customer Care 75
  right-click 8
  technical support
    user forums 76
    web sites 75
high resolution printing
  2400 x 1200 dpi 8, 37, 56, 61, 81
  PhotoREt 8, 37, 56, 61, 81
How Do I? tab 15
HP Customer Care 75
  phone numbers 78
I
I/O interface 81
icons, print cartridge status 43
IN tray
  capacity of 82
  use 5
index cards
  printing 35
  specifications 82
  tray capacity 82
infrared 22
  Infrared Data Association 23
  infrared lens 4
  solid beam 4
infrared printing
  JetSend 28
  setting up a laptop or notebook 23
  supported devices 22
  supported operating systems 22
  using a laptop or notebook 23
  choosing an infrared port 24
  displaying the Infrared Taskbar Icon 25
  enabling 23
  preparing to print 24
  printing 25
  using a Palm Pilot 26
  using a Windows CD device 28
  using an HP PhotoSmart digital camera 27
ink
drying time 10
Estimated Ink Level tab 14
ink levels, see Low on Ink
ordering 87
part numbers 14
replacing 44
streaking 46
supplies 87
volume 10, 67
ink cartridges
   cleaning 46–48
damage from refilling 49
Light 45
ordering 87
part numbers 44, 49
problems 46
replacement 44
status 42
storing 46
using 46
installing
   printer software 51, 52
   problems 51, 52
   software 51
USB cable 55

Ir 22
Ir, see infrared
IrDA 23
iron-on transfers
   ordering 90
   printing 39
J
jams, see paper jams
JetSend 28
L
labels
   paper jams with 57, 62, 63
   printing 36
   specifications 82
   tray capacity 82
landscape orientation 9, 12, 65
language codes 86
lights
   Infrared 81
   Infrared (Ir) Lens 4
   Online 4
   Power 4, 81
   Print Cartridge Status 4, 42, 45
   Resume 4, 81
Low Memory Mode 10
Low on Ink
   checking ink level 14, 42
   print cartridge status light 42, 43
M
maintenance
   print cartridges 42
   printer 29
manual two-sided printing 31
margins, minimum printing 85
media, see paper
metric paper sizes 82
mirror image 9
modes
   2400 x 1200 dpi 81
   Best 81
   Draft 81
   Normal 81
   printing speeds 81
   multiple copies 9
   multiple pages per sheet 9, 12
   2 pages per sheet 9
   4 pages per sheet 9
   draw page border 9, 12
online support, web sites 75
operating environment 81
Ordered Printing 12
ordering
  manuals 88
  paper and other media 89–90
  regional phone numbers 91–92
  supplies 87
orientation 9, 12
OUT Tray 5
  Extension 5

paper
  adjusting paper guides 5
  minimum printing margins 85
  ordering 89–90
  printing on different types 30
  size, recommended 82
  specifications 82
  supported types 82, 89, 90
  User Defined Size 82
  weight, recommended 82
paper guides 5
paper jams, clearing 57, 62, 63
paper orientation
  landscape 9, 12, 65
  portrait 9, 12, 65
paper sizes
  resizing to fit 8
  selecting 8, 12
  specifications 82, 85
  User Defined 82
paper trays
  adjusting paper guides 5
  capacity 82
  envelope slot 5
  IN tray 5
  OUT tray 5
  positions 5
Paper Type 8, 12
  parts
    numbers 87
    ordering 87
    supplies 87
Photo Paper Printing 8, 37, 56, 61, 81
photo paper printing resolution 81
photographs
  printing 37
PhotoREt 8, 37, 56, 61, 81
portrait orientation 9, 12, 65
posters
  printing 9, 12, 40
Power
  button 81
  consumption 81
  cord, ordering 87
  light 81
  previewer 9
print cartridge status 42
  icons 43
print Cartridge Status light 81
print cartridges
  cleaning 46–48
  damage from refilling 49
  light 45
  low on ink 43
  ordering 87
  part numbers 14, 44, 49, 87
  problems 45, 46
  recommended temperatures 46
  replacement 44
  status 42
  status light 4
  storing 46
  using 46
Print in Grayscale
  Windows 3.1x 13
  Windows 95, 98, 2000, NT 4.0 10
print margins
  specifications 85
print order 9
print problems, see problems
print quality
  2400 x 1200 dpi 8
  improving 66
  PhotoREt 8
  problems 66, 69
  selecting 8, 12
  using refilled print cartridges 49
Index

print settings
  changing 8
  current 8
  factory 8
  selecting 8
  software 6
  tabs 8

printer
  accessories 87
  buttons 4
  cable, parallel 53, 87
  cable, USB 55, 60, 61, 87
  calibration 14
  cleaning 29
  connections 56
  driver updates, see printer software, updates
  drivers, see printer software
  Lights 4
  maintenance 29
  paper trays 82
  parts 87
  repair 77
  settings 6
  smudges on 29
  software 6, 76
  software updates 76
  specifications 81
  trays 5

Printer Properties dialog box
  Windows 3.1x 11
  Windows 95, 98, 200, NT 4.0 7

Printer Services tab
  Windows 3.1x 15
  Windows 95, 98, 2000, NT 4.0 14

Printer Settings Taskbar Icon 16
  Default Print Settings dialog box 17
  displaying print cartridge warning messages 18
  opening the Printer Properties dialog box 18
  shortcut menu 18
  warning message indicator 16

printer settings, see print settings

printer software
  basic use 8
  downloading 76
  how to access 6
  print settings 8
  printer properties 8
  problems installing 51
  settings 8
  tabs 8
  updates 76

printing
  2400 x 1200 dpi 8, 37
  banners 41
  book 31
  borders 9
  business cards 35
  color 10
  envelopes, single 33
  envelopes, stack 34
  faxes 59
  from last page 9
  grayscale 10
  greeting cards 38
  how to print 6
  in DOS 11
  in Windows 3.1x 11
  in Windows 95, 98, 2000, NT 7
  index cards 35
  iron-on transfers 39
  labels 36
  mirror image 9
  multiple copies 9
  multiple pages per sheet 9
  orientation 9
  photographs 37
  PhotoREt 8, 37
  posters 40
  quality 45, 66
  small media 35
  tablet 31
  transparencies 32
  two-sided, book 9
  two-sided, tablet 9

printing problems, see problems
problems
Automatic paper type 70
automatic two-sided printing 71–72
banner printing 68
blank page came out of printer 59
CD, not reading 51
didn’t use printer default settings 69
error writing to USB port 60
fax 59
flushing lights 62
help 50
infrared light flashing 64
infrared printing 73–74
ink streaks 46
installing printer software 52
jam 57, 62, 63
LPT1 error 60
missing lines or dots 46
no page came out 56, 57, 58
output 65, 66
page didn’t print 56, 57, 58
paper falls to the floor 70
paper jam 57, 62, 63
parts of output in wrong place 65
parts of output missing 46, 65
photos 69
power light flashing 62
print cartridge status light flashing 63
print cartridges 46
print quality 66, 67, 69
printer won’t turn on 61
printing 56–61
printing at an angle or off-center 65
resume light flashing 62, 63
slow printer 60, 61
software installation 52
software, not reading 51
too much ink 67
uninstalling printer software 52
upper lights flashing 64
USB 53, 54, 55, 59, 60, 61
Q
quality, see print quality
R
rear access door
removing 57, 62
replacement parts 87
regulatory notices 93
repair of printer 77
requirements, system 85
resolution
2400 x 1200 dpi 8, 37
best 81
color 81
draft 81
normal 81
photo paper printing 81
PhotoREt 8, 37
specifications 81
Resume button 81
Resume light 81
reverse printing 9, 12
S
Saturation 10
Scale to Fit 8
selecting
paper size 8
paper type 8
print settings 8
Services
consider the printer 14
clean print cartridges 14
electronic User’s Guide 14
test page 14
toolbox 13
Services tab 13
settings, see print settings
setup
problems 51–55
Setup Poster
ordering 88
Setup tab
Windows 3.1x 12
Windows 95, 98, 2000 and NT 4.0 8
Show HP Preview 9
single envelope slot 5
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>size</td>
</tr>
<tr>
<td>media</td>
</tr>
<tr>
<td>Scale to Fit</td>
</tr>
<tr>
<td>User Defined Paper Size</td>
</tr>
<tr>
<td>small media</td>
</tr>
<tr>
<td>printing</td>
</tr>
<tr>
<td>software compatibility</td>
</tr>
<tr>
<td>software, see printer software</td>
</tr>
<tr>
<td>specifications</td>
</tr>
<tr>
<td>Automatic Two-Sided Printing Module</td>
</tr>
<tr>
<td>infrared printing</td>
</tr>
<tr>
<td>paper</td>
</tr>
<tr>
<td>printer</td>
</tr>
<tr>
<td>printing margins</td>
</tr>
<tr>
<td>speed, printing</td>
</tr>
<tr>
<td>Start Printing from Last Page</td>
</tr>
<tr>
<td>status, Print Cartridge Status light</td>
</tr>
<tr>
<td>streaking ink</td>
</tr>
<tr>
<td>stuck paper, see paper jams</td>
</tr>
<tr>
<td>supplies</td>
</tr>
<tr>
<td>ordering</td>
</tr>
<tr>
<td>paper and other media</td>
</tr>
<tr>
<td>part names and numbers</td>
</tr>
<tr>
<td>system requirements</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>T</th>
</tr>
</thead>
<tbody>
<tr>
<td>tablet binding</td>
</tr>
<tr>
<td>tabs</td>
</tr>
<tr>
<td>Advanced</td>
</tr>
<tr>
<td>Color</td>
</tr>
<tr>
<td>Configuration</td>
</tr>
<tr>
<td>Estimated Ink Level</td>
</tr>
<tr>
<td>Features</td>
</tr>
<tr>
<td>How Do I?</td>
</tr>
<tr>
<td>Printer Services</td>
</tr>
<tr>
<td>Services</td>
</tr>
<tr>
<td>Setup</td>
</tr>
<tr>
<td>technical support</td>
</tr>
<tr>
<td>Toolbox, DeskJet</td>
</tr>
<tr>
<td>transfers, printing</td>
</tr>
<tr>
<td>transparencies</td>
</tr>
<tr>
<td>printing</td>
</tr>
<tr>
<td>specifications</td>
</tr>
<tr>
<td>trays</td>
</tr>
<tr>
<td>adjusting length and width</td>
</tr>
<tr>
<td>capacity</td>
</tr>
<tr>
<td>envelope slot</td>
</tr>
<tr>
<td>IN Tray</td>
</tr>
<tr>
<td>IN tray</td>
</tr>
<tr>
<td>OUT Tray</td>
</tr>
<tr>
<td>positions</td>
</tr>
<tr>
<td>use</td>
</tr>
<tr>
<td>troubleshooting, see problems</td>
</tr>
<tr>
<td>two-sided printing</td>
</tr>
<tr>
<td>automatic</td>
</tr>
<tr>
<td>manual</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>U</th>
</tr>
</thead>
<tbody>
<tr>
<td>uninstalling printer software</td>
</tr>
<tr>
<td>updates for software</td>
</tr>
<tr>
<td>USB</td>
</tr>
<tr>
<td>enabling</td>
</tr>
<tr>
<td>hubs</td>
</tr>
<tr>
<td>increasing speed</td>
</tr>
<tr>
<td>installation</td>
</tr>
<tr>
<td>problems</td>
</tr>
<tr>
<td>User's Guide, ordering</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>W</th>
</tr>
</thead>
<tbody>
<tr>
<td>warranty</td>
</tr>
<tr>
<td>extensions</td>
</tr>
<tr>
<td>statement</td>
</tr>
<tr>
<td>web sites</td>
</tr>
<tr>
<td>Windows 3.1x</td>
</tr>
<tr>
<td>features</td>
</tr>
<tr>
<td>printer properties</td>
</tr>
<tr>
<td>printing</td>
</tr>
<tr>
<td>settings</td>
</tr>
<tr>
<td>tabs</td>
</tr>
<tr>
<td>toolbox</td>
</tr>
<tr>
<td>Windows 95, 98, 2000, NT 4.0</td>
</tr>
<tr>
<td>features</td>
</tr>
<tr>
<td>printer properties</td>
</tr>
<tr>
<td>printing</td>
</tr>
<tr>
<td>settings</td>
</tr>
<tr>
<td>tabs</td>
</tr>
<tr>
<td>toolbox</td>
</tr>
</tbody>
</table>